Developer/2000™

Client/Server Installation Guide for AIX-Based Systems

Release 1.6

February 1998
Part No. A59967-01
Send Us Your Comments .................................................................................................................. vii

Preface ............................................................................................................................................. ix

1 Features and Requirements

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1-2</td>
</tr>
<tr>
<td>Installation Overview</td>
<td>1-4</td>
</tr>
<tr>
<td>Client-Only Installation</td>
<td>1-4</td>
</tr>
<tr>
<td>Server-Based Installation</td>
<td>1-6</td>
</tr>
<tr>
<td>Client-Only and Server-Based Issues</td>
<td>1-8</td>
</tr>
<tr>
<td>Supported User Interfaces</td>
<td>1-9</td>
</tr>
<tr>
<td>Online Documentation and Help</td>
<td>1-10</td>
</tr>
<tr>
<td>Installation Guide</td>
<td>1-10</td>
</tr>
<tr>
<td>Context-Sensitive Online Help</td>
<td>1-10</td>
</tr>
<tr>
<td>Cue Cards</td>
<td>1-11</td>
</tr>
<tr>
<td>Related Publications</td>
<td>1-11</td>
</tr>
<tr>
<td>System Requirements</td>
<td>1-12</td>
</tr>
<tr>
<td>Hardware Requirements</td>
<td>1-12</td>
</tr>
<tr>
<td>Operating System Requirements</td>
<td>1-12</td>
</tr>
<tr>
<td>User Interface Requirements</td>
<td>1-13</td>
</tr>
<tr>
<td>Server Requirements for Developer/2000</td>
<td>1-13</td>
</tr>
<tr>
<td>Relinking Requirements</td>
<td>1-13</td>
</tr>
<tr>
<td>Server Manager Installation under AIX 4</td>
<td>1-13</td>
</tr>
<tr>
<td>Disk Space and Memory Requirements</td>
<td>1-14</td>
</tr>
<tr>
<td>Calculating Space Requirements</td>
<td>1-14</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>1-14</td>
<td>Calculating Total Disk Space Required</td>
</tr>
<tr>
<td>1-17</td>
<td>Issues and Restrictions</td>
</tr>
<tr>
<td>1-17</td>
<td>Client-Only versus Server Installs</td>
</tr>
<tr>
<td>1-17</td>
<td>National Language Support for Developer/2000</td>
</tr>
</tbody>
</table>

2 Setting the Environment
- Pre-Installation Tasks | 2-2 |

3 Installation Tasks
- Using the Oracle Installer | 3-2 |
- Install Online Documentation | 3-8 |
- Software Upgrade | 3-10 |
- Creating or Upgrading Database Objects | 3-11 |

4 Completing Developer/2000 Installation
- Completing the Online Documentation Installation | 4-2 |
- Verifying Your Installation | 4-7 |
- Setting Printer Configuration Files | 4-8 |
- Setting Up the Developer/2000 Environment | 4-15 |
- Setting Up the Character Mode User Environment | 4-17 |
- Setting Up the GUI Environment | 4-20 |
- Getting Help with X and OSF/Motif | 4-20 |
- Enabling Use of Other Languages | 4-23 |

5 Configuring Oracle Forms
- Product Documentation | 5-2 |
- Online Help | 5-2 |
- relnotes.txt File | 5-2 |
- Administering Forms | 5-3 |
- Executables | 5-3 |
- Edit Preferences | 5-3 |
- Source File Locations | 5-4 |
- Setting UNIX Environment Variables | 5-4 |
- Using Forms | 5-6 |
6 Configuring Oracle Reports

Product Documentation................................................................. 6-2
relnotes.txt File ........................................................................ 6-2

Administering Reports .................................................................. 6-3
Executables ................................................................................. 6-3
Relinking Reports ........................................................................ 6-4
Edit Preferences .......................................................................... 6-4
Report Doc Option ...................................................................... 6-5
Text Format Filename Extension ................................................. 6-5
Call Interface ............................................................................... 6-6
Filename Extensions ..................................................................... 6-7
Online Tools for Administration .................................................. 6-8
Printer Definitions ....................................................................... 6-8
Setting UNIX Environment Variables .......................................... 6-9
Specifying Printers and Queues ................................................... 6-12

Using Reports .............................................................................. 6-13
Starting Reports Runtime ......................................................... 6-13
Starting Reports Designer ......................................................... 6-13
Printing Reports ......................................................................... 6-13
Motif Compliance ....................................................................... 6-15
Escape to Host ............................................................................ 6-15
User Exits .................................................................................. 6-15
Demonstration Files and Applications ........................................ 6-16

7 Configuring Oracle Graphics

Product Documentation.................................................................. 7-2
Online Help ................................................................................ 7-2
relnotes.txt File ........................................................................ 7-2

Administering Graphics ............................................................... 7-3
11 Running the Developer/2000 Integrated Demonstration
The Integrated Demonstration for Developer/2000 ................................................................. 11-2

12 Creating User Exits
User Exits .................................................................................................................................. 12-2
Forms ......................................................................................................................................... 12-3
Reports ...................................................................................................................................... 12-3
Graphics .................................................................................................................................... 12-4
Linking in Your User Exits .......................................................................................................... 12-4

A Configuring Toolkit Resources
The Resource Database ............................................................................................................ A-1
Set Oracle Toolkit/Motif Resources in the Tk2Motif File .......................................................... A-7

Index
Send Us Your Comments

Developer/2000 Client/Server Installation Guide for AIX-Based Systems, Release 1.6
Part No. A59967-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual?

If you find any errors or have other suggestions for improvement, please indicate the chapter, section, and page number (if available). You can send comments to us in the following ways:

- osdwrite@us.oracle.com
- FAX - 1.650.506.7360   Attn.: Publications Manager, Oracle Technology Network
- postal service:
  Lynn Robinson
  Oracle Technology Network
  500 Oracle Parkway, Mailstop 1op3
  Redwood Shores, CA 94065
  USA

If you would like a reply, please give your name, address, and telephone number below.
This *Developer/2000 Client/Server Installation Guide for AIX-Based Systems* provides AIX installation and configuration information for Release 1.6 of *Developer/2000*.

The topics covered in this preface are:

- **Audience**
- **Document Conventions**
- **Contacting Customer Support**
- **Documentation Sales and Client Relations**

**Audience**

This document is for database administrators and others responsible for installing Oracle products on UNIX operating systems. While command examples are provided, this document does not attempt to teach Oracle or UNIX administration.

**Additional Reading**

For additional information on *Developer/2000*, see the product documentation for Oracle Book, Oracle Browser, Oracle Forms, Oracle Graphics, Oracle Procedure Builder, and Oracle Reports.

**Document Conventions**

Conventions used in this document differ somewhat from those used in other Oracle documentation. Because UNIX is case-sensitive, commands and filenames are shown in monospace type, rather than uppercase letters.
Type Conventions

Following are the type conventions:

---

**monospace**

Monospace type indicates UNIX commands, directory names, pathnames, and filenames (for example, the `prefs.ora` file).

**brackets [ ]**

Words enclosed in brackets indicate key names (for example, press [Return]).

**italics**

Italic type indicates a variable and is used for emphasis. It also indicates variable portions of filenames (for example, `sgdeft.dbf`).

**UPPERCASE**

Uppercase letters indicate Oracle commands, initialization parameters, and environment variables (for example, `ORACLE_HOME`).

---

Command Syntax

Commands appear in monospace font. Enter information exactly as it appears. Following are the syntax conventions for commands:

- **backslash \**
  
  A backslash indicates a command line that is too long to fit on the printed page. Either enter the line as printed (with a backslash) or enter it as a single line without a backslash.

- **braces {}**
  
  Braces indicate required items.

- **BRACKETS**
  
  Brackets indicate optional items.

- **ellipsis ...**
  
  An ellipsis indicates an arbitrary number of similar items.

- **italics**
  
  Italic type indicates a variable. Substitute a value for the variable.

- **vertical line |**
  
  A vertical line indicates a choice within braces or brackets.
Contacting Customer Support

Please copy this page and distribute it within your organization as necessary.

Oracle Worldwide Customer Support (WWCS) can be reached at the following numbers (the hours are specified in your support contract):

• In the United States, call: 1.650.506.1500.
• In Europe, call: +44.1344.860160.
• In Asia, call: +81.3.5717.1850.

Please prepare the following information before you call:

• Your CSI number (if applicable) or complete contact details, including any special project information.
• The release levels of Developer/2000 and associated products (for example, Oracle7 Server release 7.3.3 and Oracle Forms release 4.5.6.3.2).
• Operating system name and release level, including patches and packages.
• Details of error codes, numbers, and descriptions associated with the problem.
• A full description of the issue, including:
  • What happened? For example, the command used and result obtained.
  • When did it happen? For example, time of day, or after a particular command, or after an operating system or Oracle upgrade.
  • Where did it happen? For example, on a particular system, or within a particular procedure or table.
  • What is the extent of the problem? For example, is your production system unavailable, or is the impact less severe? Is the problem getting worse? Keep in mind what did not happen, as well as what did happen.
• Copies of any trace files, core dumps, or log files recorded near the incident.

For installation-related problems, please have the following information available:

• Listings of the contents of the ORACLE_HOME directory, and any staging area, if applicable.
• Contents of the installation log files in the $ORACLE_HOME/orainst directory: install.log, sql.log, make.log, and os.log.

For more information, contact http://www.oracle.com/support.
Documentation Sales and Client Relations

In the United States:

- To order hardcopy documentation, call Documentation Sales: 1.800.252.0303.
- For shipping inquiries, product exchanges, or returns, call Client Relations: 1.650.506.1500.

In the United Kingdom:

- To order hardcopy documentation, call Oracle Direct Response: +44 990 332200.
- For shipping inquiries and upgrade requests, call Customer Relations: +44 990 622300.

Other European customers, please contact your local Oracle Support office for documentation or shipping inquiries.
This chapter provides an overview of features and installation requirements for Developer/2000 Client/Server.

Completing a quick, successful installation depends on the local system satisfying the software dependencies and space requirements for Oracle software. This chapter describes the requirements for installing Developer/2000 Release 1.6 on AIX 4.1. Verify that the system meets the requirements described in this chapter before starting the installation.

The following topics are covered in this chapter:

• Introduction
• Installation Overview
• Supported User Interfaces
• Online Documentation and Help
• Related Publications
• System Requirements
• Disk Space and Memory Requirements
• Issues and Restrictions
Introduction

Developer/2000 is an integrated set of database tools supporting multiple platforms, user interfaces, and data sources. These tools are built on top of a layer called Oracle Toolkit, which provides a uniform programming interface to the underlying user interface. Oracle Toolkit makes it possible to create applications that run against multiple user interfaces, such as Motif or Windows, while retaining the full native look and feel of the interface.

Installing Developer/2000 involves the following steps:

1. **Satisfy Prerequisites:** Make sure that the local system satisfies the hardware, software, memory, and disk space requirements for the products you want to install.

2. **Check the UNIX Environment:** Make sure that the UNIX environment is properly set up for the products you want to install.

3. **Install:** Use the Oracle Installer to install the Oracle software.

4. **Create User Exits:** This is optional.


**See Also:** *Developer/2000 Installation Guide for the Web Release 1.6*

Developer/2000 tools are built using standard application programming interfaces (APIs), allowing organizations to supplement the Developer/2000 product set with tools from other vendors.
The following products are supported in Developer/2000 Client/Server.

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Book</td>
<td>Use Oracle Book to create and view online documents. Online help documents available in this release were developed using Oracle Book.</td>
</tr>
<tr>
<td>Release 2.2</td>
<td></td>
</tr>
<tr>
<td>Oracle Browser</td>
<td>Use Browser to query databases. Both non-programmers and experienced database users and programmers can use Browser.</td>
</tr>
<tr>
<td>Release 2.0</td>
<td></td>
</tr>
<tr>
<td>Oracle Forms</td>
<td>Use Forms to build interactive applications that access Oracle Server data. With Developer/2000 for the Web Release 1.6, you can deploy Forms on the Web, as well as in Motif and character mode.</td>
</tr>
<tr>
<td>Release 4.5</td>
<td></td>
</tr>
<tr>
<td>Oracle Graphics</td>
<td>Use Graphics to create multimedia graphical displays dynamically linked to a database. With Developer/2000 for the Web Release 1.6, your Web publications can be enhanced with data-driven graphic displays.</td>
</tr>
<tr>
<td>Release 2.5</td>
<td></td>
</tr>
<tr>
<td>Oracle Procedure</td>
<td>Use Procedure Builder to create, edit, and debug PL/SQL code.</td>
</tr>
<tr>
<td>Builder Release</td>
<td></td>
</tr>
<tr>
<td>1.5</td>
<td></td>
</tr>
<tr>
<td>Oracle Reports</td>
<td>Use Reports to build and generate reports that access Oracle Server data. With Developer/2000 for the Web Release 1.6, you can deploy Reports on the Web, as well as in Motif and character mode.</td>
</tr>
<tr>
<td>Release 2.5</td>
<td></td>
</tr>
</tbody>
</table>
Installation Overview

Your installation type determines the installation tasks that you perform. These tasks are described later in this manual.

Note: Oracle Corporation recommends that you conduct a client-only installation whenever possible. Client-only installations simplify administration and upgrades.

Client-Only Installation

In a client-only installation, the Developer/2000 tools are installed in an ORACLE_HOME directory separate from the ORACLE_HOME directory that contains the database server the tools access. You use SQL*Net to access your remote database server.


You must install the tools for each installation. You need to install the database objects only once for each server.
Client-Only Configuration
This figure illustrates a configuration in which Developer/2000 is installed on client machines connecting to the database server with SQL*Net.

Figure 1–1  Client-Only Installation

UNIX server runningOracle RDBMS
Database objects forDeveloper/2000 tools reside here

SQL*Net

Client machine running Developer/2000

Note: You can also perform a client-only installation on the same machine as the Oracle Server, as long as you use a different ORACLE_HOME.
Server-Based Installation
In a server-based installation, Developer/2000 and the Oracle Server are installed in the same ORACLE_HOME directory. Developer/2000 connects to the local database.

Attention: Developer/2000 should always be installed after the database is installed.

Server-Based Configuration
The following figure illustrates a configuration in which the Oracle Server and Developer/2000 are installed in the same ORACLE_HOME directory.
Server-Based Restriction

Oracle Corporation recommends client-only installations for Developer/2000. Oracle Applications customers may be required to install Developer/2000 in a server-based configuration on UNIX platforms. For only these customers, Oracle supports installation on top of several Oracle servers. Customers who are not installing Developer/2000 for Oracle Applications should install Developer/2000 in a client-only configuration.

For the latest certification information, please visit Oracle’s Web-based support service, Oracle MetaLink, at: http://support.oracle.com or contact Oracle Worldwide Customer Support.
If you are upgrading from a previous release of Developer/2000, you can install Release 1.6 over the existing Developer/2000 installed product set as long as you follow the server-based restriction listed above.

**Client-Only and Server-Based Issues**

This section presents issues to consider when you are deciding on a client-only or a server-based installation.

**Client-Only Installations**

Advantages of client-only configurations:

- You do not need to upgrade the database and Developer/2000 simultaneously.
- Performance is generally enhanced if Developer/2000 is running on local workstations. This reduces the load on the servers.

**Server-Based Installations**

Advantages of server-based configurations:

- Server-based installations save disk space.
- Because Developer/2000 and the Oracle Server share some of the same libraries, the system administrator does not need to duplicate and maintain the shared configuration files.
Supported User Interfaces

Table 1-1 lists the Developer/2000 Release 1.6 tools and whether they support character mode, Motif, and Web interfaces on AIX:

Table 1-1  Developer/2000 Release 1.6 Tools

<table>
<thead>
<tr>
<th>Oracle Product</th>
<th>Character Mode</th>
<th>Motif (v1.2.3)</th>
<th>Web</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Book release 2.2</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Oracle Browser version 2.0</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Oracle Forms release 4.5</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle Graphics release 2.5</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle Reports release 2.5</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Oracle Procedure Builder release 1.5</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Note:  Web interfaces are only available in the Developer/2000 for the Web release, not in the Developer/2000 Client/Server release.

Note:  Developer/2000 does not have a character mode designer, and there is no character mode runtime component for Graphics or Browser. The designer component of all Developer/2000 products, and the runtime component of Graphics and Browser, support only the Motif graphical user interface.
Online Documentation and Help

Installation Guide

After installation, you can find the HTML and PDF files for this document in the orainst directory on the Developer/2000 Installation CD-ROM. To view the installation guide online, cd to the orainst directory on the Developer/2000 installation area, and run the oraview utility. For instance, if you mounted the Developer/2000 CD-ROM on the /cdrom directory, to view the documentation in GUI Motif mode, enter the following commands:

cd /cdrom/oracle/orainst
./oraview -m /cdrom/oracle/orainst/doc

For character mode, enter:

cd /cdrom/oracle/orainst
./oraview -c /cdrom/oracle/orainst/doc

Depending on your platform, you may need to navigate within the ORACLE_DOC subdirectories to find this document.

Context-Sensitive Online Help

Developer/2000 provides a context-sensitive online help system. Access online help by selecting Contents from the Help menu.

For example, if you are in a Reports property sheet and need information about a current setting, select Help-Contents. A window containing one or more pages of information about that setting is displayed. If the page shown extends beyond the window, use [Scroll Down] to display the rest of the page. When you have finished reading help files, select Quit.
Cue Cards

Cue cards provide step-by-step instructions on common tasks. To access cue cards, select the Help pull-down menu, then select Cue Cards.

On AIX, cue cards support playing AVI video files using the Show Me buttons. To play the video files, you must have an external video player program, such as xanim, installed on your machine. You also need to set the MMTK_AVIFPLAYER environment variable to specify the video player program that will play the AVI video files. Set MMTK_AVIFPLAYER as follows:

For the Bourne shell, enter:

```sh
$ MMTK_AVIFPLAYER="video_player_name %s &"; \\
export MMTK_AVIFPLAYER
```

For the C shell, enter:

```sh
% setenv MMTK_AVIFPLAYER "video_player_name %s &"
```

Where:

- `video_player_name` is the name of the AVI video player program
- `%%s` is the name of the AVI video player program
- `&` forces the video player to run in the background

Related Publications

**Oracle7 Server for UNIX Documentation**

The following documents provide additional information and are included on your CD-ROM in HTML format:

- *Oracle7 Installation Guide for AIX 4.1*: Part# A42912
- *Oracle7 Administrator’s Reference for UNIX*: Part# A42808
- *Oracle7 Reference Addendum for AIX 4.1*: Part# A42923
System Requirements

This section describes the system requirements for installing Developer/2000 on AIX.

Hardware Requirements

Table 1–2 lists hardware requirements for installing and running Developer/2000 on AIX.

<table>
<thead>
<tr>
<th>Hardware Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>An AIX-based system</td>
</tr>
<tr>
<td>Memory</td>
<td>A minimum of 32 MB internal memory (RAM)</td>
</tr>
<tr>
<td>Swap Space</td>
<td>2-4 times physical RAM</td>
</tr>
<tr>
<td>Media Device</td>
<td>A CD-ROM drive that can read ISO 9660 standard format</td>
</tr>
<tr>
<td>Display Device for GUI Tools</td>
<td>X11 Server</td>
</tr>
</tbody>
</table>

Operating System Requirements

Table 1–3 lists operating system requirements for installing and running Developer/2000 on AIX.

To determine which operating system patches are installed, enter:

```bash
$ showrev -p
```

<table>
<thead>
<tr>
<th>Software Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>AIX 4.1.5 or AIX 4.2.1</td>
</tr>
</tbody>
</table>

**Note:** You must also apply IBM PTF SLHS U449507 if you are using AIX 4.1.5. This step is unnecessary if you are using AIX 4.2.1.

In addition, please ensure that the pthreads library has been installed from your AIXC distribution CD-ROM.

To determine your operating system and processor type, enter:

```bash
$ uname -a
```
User Interface Requirements

Table 1–4 lists user interface requirements for installing and running Developer/2000 products on AIX.

<table>
<thead>
<tr>
<th>Software Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Manager</td>
<td>Motif Window Manager mwm, delivered with AIX 4.1.5 or 4.2.1</td>
</tr>
<tr>
<td>X11 Server</td>
<td>X11R5 and Motif 1.2.3 delivered with AIX 4.1.5 or 4.2.1</td>
</tr>
</tbody>
</table>

Server Requirements for Developer/2000

The Oracle7.3.3 Server release supports Developer/2000 on AIX.

WARNING: If you install Developer/2000 in the same ORACLE_HOME directory where a release earlier than 7.3.3 of the Oracle7 Server resides, or in a later release which has not been certified (see server-based restrictions above), you will overwrite common component product layers. You will be unable to relink the Oracle7 Server and you may be unable to use the database. Oracle Corporation does not support this configuration.

Relinking Requirements

You can relink the Motif Developer/2000 tools using dynamic Motif and X11 libraries.

The Developer/2000 distribution provides all necessary components for relinking the character mode Developer/2000 tools.

You do not need to relink unless you plan to link user exits or add network drivers.

Server Manager Installation under AIX 4

You will need to obtain PTF U437181 if the Oracle Installer fails in relinking Server Manager 2.1 Motif executables due to these undefined symbols:

_XmSetFocusFlag
Disk Space and Memory Requirements

Table 1–5 lists disk space, database space, and memory requirements for Developer/2000. These are minimal estimates, not precise calculations.

Calculating Space Requirements

Below are the steps necessary to calculate space requirements.

1. Calculate the distribution space by subtotaling the values for the selected products in the Total Distribution Space box at the bottom of the column.

2. Calculate the database space by subtotaling the values for the selected products in the Total Database Space box at the bottom of the column.

3. Add the total distribution space and total database space values and enter the amount in the Total Space Requirements box.

Calculating Total Disk Space Required

Add the Total Distribution Space columns from Distribution (MB) and DB Space (MB) to determine the total required disk space for your installation.

Table 1–5 Space Requirements for Developer/2000

<table>
<thead>
<tr>
<th>Products and Options</th>
<th>Distribution (MB)</th>
<th>DB Space (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUI Common Area</td>
<td>24.8</td>
<td>0.53</td>
</tr>
<tr>
<td>Oracle Forms</td>
<td>43.0</td>
<td>0.32</td>
</tr>
<tr>
<td>Runtime (Char.)</td>
<td>12.2</td>
<td>0</td>
</tr>
<tr>
<td>Designer (Motif)</td>
<td>15.1</td>
<td>0</td>
</tr>
<tr>
<td>Runtime (Motif)</td>
<td>18.4</td>
<td>0</td>
</tr>
<tr>
<td>Generator (Char.)</td>
<td>12.4</td>
<td>0</td>
</tr>
<tr>
<td>Generator (Motif)</td>
<td>13.7</td>
<td>0</td>
</tr>
<tr>
<td>Forms Demonstrations</td>
<td>7.9</td>
<td>0</td>
</tr>
</tbody>
</table>
Table 1–5  Space Requirements for Developer/2000

Space Requirements: Applications Development and Standalone Products

<table>
<thead>
<tr>
<th>Products and Options</th>
<th>Distribution (MB)</th>
<th>DB Space (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Reports</td>
<td>72.7</td>
<td>0.39</td>
</tr>
<tr>
<td>Converter</td>
<td>15.2</td>
<td>0</td>
</tr>
<tr>
<td>Designer (Motif)</td>
<td>19.2</td>
<td>0</td>
</tr>
<tr>
<td>Migration Utility</td>
<td>10.4</td>
<td>0</td>
</tr>
<tr>
<td>Runtime (Char.)</td>
<td>14.4</td>
<td>0</td>
</tr>
<tr>
<td>Runtime (Motif)</td>
<td>18.5</td>
<td>0</td>
</tr>
<tr>
<td>Reports Demonstrations</td>
<td>24.6</td>
<td>0</td>
</tr>
<tr>
<td>Oracle Graphics v2</td>
<td>32.6</td>
<td>0.12</td>
</tr>
<tr>
<td>Designer (Motif)</td>
<td>15.6</td>
<td>0</td>
</tr>
<tr>
<td>Runtime (Motif)</td>
<td>15.6</td>
<td>0</td>
</tr>
<tr>
<td>Graphics Demonstrations</td>
<td>5.1</td>
<td>0</td>
</tr>
<tr>
<td>Oracle Book v2</td>
<td>44.4</td>
<td>1.31</td>
</tr>
<tr>
<td>Designer (Motif)</td>
<td>7.5</td>
<td>0</td>
</tr>
<tr>
<td>Runtime (Char.)</td>
<td>6.8</td>
<td>0</td>
</tr>
<tr>
<td>Runtime (Motif)</td>
<td>8.1</td>
<td>0</td>
</tr>
<tr>
<td>Converter</td>
<td>5.8</td>
<td>0</td>
</tr>
<tr>
<td>OB2 HTML</td>
<td>3.6</td>
<td>0</td>
</tr>
<tr>
<td>Demonstrations</td>
<td>0.6</td>
<td>0</td>
</tr>
<tr>
<td>Oracle Browser v2</td>
<td>8.0</td>
<td>0.04</td>
</tr>
<tr>
<td>User Edition</td>
<td>6.9</td>
<td>0</td>
</tr>
<tr>
<td>Extended Edition</td>
<td>6.9</td>
<td>0</td>
</tr>
<tr>
<td>Administration Edition</td>
<td>5.9</td>
<td>0</td>
</tr>
<tr>
<td>Oracle Procedure Builder</td>
<td>12.0</td>
<td>0</td>
</tr>
<tr>
<td>Procedure Builder (Motif)</td>
<td>9.9</td>
<td>0</td>
</tr>
<tr>
<td>Oracle Installer</td>
<td>2.3</td>
<td>0</td>
</tr>
</tbody>
</table>
Disk Space and Memory Requirements

<table>
<thead>
<tr>
<th>Products and Options</th>
<th>Distribution (MB)</th>
<th>DB Space (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Common</td>
<td>7.1</td>
<td>0</td>
</tr>
</tbody>
</table>

Total Distribution Space =

Total Database Space =
Issues and Restrictions

Client-Only versus Server Installs

In a server-based installation, Developer/2000 and the Oracle Database Server are installed in the same ORACLE_HOME. Starting with Developer/2000 Release 1.6, Oracle Corporation no longer supports server-installs of Developer/2000. Only client-only installs are supported. The only exception to this is for Oracle Applications customers who may be required to install Developer/2000 on top of a pre-existing Oracle database installation.

These Applications customers should adhere to the Applications/RDBMS/Developer/2000 combination certified and supported by Oracle Applications.

For the latest certification information, please visit Oracle’s Web-based support service, Oracle MetaLink at: http://support.oracle.com or contact Oracle WorldWide Customer Support.

National Language Support for Developer/2000

Message and resource files are available in the following languages in the Motif component of Release 1.6:

- American English
- Dutch
- French
- German
- Italian
- Japanese
- Korean
- Spanish
- Traditional Chinese

Arabic Language Support

The current Developer/2000 products do not support Arabic languages on Motif.

Hebrew Language Support

Hebrew is supported on visual mode displays for Forms.
This chapter describes the recommended tasks for setting up your AIX environment for the Developer/2000 installation.
Pre-Installation Tasks

- Decide Whether to Install or Upgrade Database Objects
- Set Up the tnsnames.ora File (Client-Only)
- Set Required Environment Variables

Task 1: Decide Whether to Install or Upgrade Database Objects

**Note:** This task applies to a client-only installation. Skip this task if you are not conducting a client-only installation, or if you know you do not need to install or upgrade the database objects.

Database objects are tables, views, and sequences that Developer/2000 uses to store Developer/2000 objects, such as Oracle Forms applications and Oracle Book documents, in the database.

You must create the database objects on each database where you are storing Developer/2000 objects. If you are not storing Developer/2000 objects in your databases, you do not need to install the database objects. If you have already installed the database objects on your database, do not install them again.

If you are upgrading your Developer/2000 release, you may need to upgrade the database objects as well.

Enter the following to determine if the database objects already exist for the products you want to install in the database on the server.

```
$ sqlplus system/manager
SQL> SELECT table_name
    FROM dba_tables
WHERE table_name LIKE 'table_name';
```
If these tables already exist, you can find them in the SYSTEM account in the database. Table 2–1 lists the tables.

### Table 2–1  Database Tables

<table>
<thead>
<tr>
<th>Product</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Book</td>
<td>HT%</td>
</tr>
<tr>
<td>Oracle Browser</td>
<td>BROWSER%</td>
</tr>
<tr>
<td>Oracle Forms</td>
<td>FRM45%</td>
</tr>
<tr>
<td>Oracle Graphics</td>
<td>GO%</td>
</tr>
<tr>
<td>Oracle Reports</td>
<td>SRW2%</td>
</tr>
</tbody>
</table>

If these tables do not exist, then you must create them with the Installer.

### Task 2: Set Up the tnsnames.ora File (Client-Only)

If you are conducting a client-only installation, and you wish to install database objects, then you must set up the `tnsnames.ora` file before you run the Installer. The `tnsnames.ora` file contains details of the remote databases available to the Developer/2000 products installed in a client-only configuration.

A `tnsnames.ora` file contains the following:

```plaintext
alias =
  (DESCRIPTION =
    (ADDRESS =
      (PROTOCOL = tcp
       (HOST = hostname
        (PORT = service_number
       )
      )
    )
  )
  (CONNECT_DATA =
    (SID = ORACLE_SID)
  )
)
```

Oracle products will look for the `tnsnames.ora` file first in directory specified by the TNS_ADMIN environment (if it is set), then in `$ORACLE_HOME/network/admin`, and then in the `/var/opt/oracle` directory. Make sure to put the `tnsnames.ora` file in one of these locations; otherwise, you will not be able to connect to the database through SQL*Net.
If you have the Oracle Network Manager, then you can use it to update the file. Otherwise, you need to use an editor to update the file with the following information:

**Table 2-2 tnsnames.ora File Values**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Replace with:</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>alias</em></td>
<td>The aliased name of the service being described. This is the name that you will use to connect to the database.</td>
</tr>
<tr>
<td><em>hostname</em></td>
<td>The name of the remote host (server) where the database resides.</td>
</tr>
<tr>
<td><em>service_number</em></td>
<td>The port number on which the SQL*NET v2 listener process listens for data packets on the remote host where the database resides. This is typically defined in the /etc/services file.</td>
</tr>
<tr>
<td><em>ORACLE_SID</em></td>
<td>The value of the system identifier (sid). This is the name of the instance on the hostname above to which you want to connect.</td>
</tr>
</tbody>
</table>

Set TNS\_ADM IN If you wish to place the tnsnames.ora file in a location other than the default locations ($ORACLE\_HOME/network/admin or /var/opt/oracle), set the TNS\_ADMIN environment variable to the directory where tnsnames.ora is located. For example, if tnsnames.ora resides in the /tns directory.

Set TNS\_ADMIN to /tns.

**Task 3: Set Required Environment Variables**

Oracle Corporation recommends that you set environment variables in the startup file of the user who will own the Developer/2000 installation. Log into the oracle account and set environment variables according to the instructions in this section. The startup file, normally located in your UNIX login home directory, will vary depending upon the shell used. Typically, profile is used for the Bourne and Korn shells, and .cshrc is used for the C shell.

**Syntax of Environment Variables**

The syntax for setting an environment variable for the Bourne shell is:

```
variable_name=value; export variable_name
```

The syntax for setting an environment variable for the C shell is:

```
setenv variable_name value
```
Pre-Installation Tasks

**Set ORA_NLS33**

Set ORA_NLS33 to $ORACLE_HOME/ocommon/nls/admin/datad2k.

**Attention:** Developer/2000 will not work unless ORA_NLS33 is set correctly.

---

**Set ORACLE_HOME**

ORACLE_HOME should be set to the directory where the Oracle software will be installed.

To determine if the ORACLE_HOME environment variable is set, enter:

```
$ echo $ORACLE_HOME
$ ls $ORACLE_HOME
```

If ORACLE_HOME is set correctly, then the `ls $ORACLE_HOME` command should list the oracle directories in $ORACLE_HOME. If previously set, then the system displays the value of ORACLE_HOME.

**Set ORACLE_BASE**

ORACLE_BASE is required for OFA-compliant installations. This variable defines the base of the directory structure for your Oracle installation. The `oracle` operating system user must have read, write, and execute privileges on this directory.

If ORACLE_BASE is undefined, then the Oracle Installer derives the value of ORACLE_BASE from the mount point you provide: `mount_point/app/oracle`. If you define it before starting the Installer session, then the Installer takes the value of ORACLE_BASE from the environment.

If you are upgrading, then the Installer checks if you have defined ORACLE_BASE in a prior installation, to determine if the upgrade should be performed in an OFA-compliant structure.

**Set ORACLE_TERM**

You can run the Installer in either Motif or character mode. If you want to run the Installer in character mode, then set the ORACLE_TERM environment variable to the correct terminal type before installing Developer/2000.

For example, to use a vt220 terminal type either:

```
$ORACLE_TERM=vt220; export ORACLE_TERM
```
or

```
% setenv ORACLE_TERM vt220
```

If ORACLE_TERM is not set, then the Installer uses the value of the UNIX environment variable TERM and searches for an equivalent ORACLE_TERM resource file.

Table 2–3 lists common ORACLE_TERM settings:

<table>
<thead>
<tr>
<th>To Run:</th>
<th>Set ORACLE_TERM to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI terminal for SCO</td>
<td>ansi</td>
</tr>
<tr>
<td>AT386 console</td>
<td>386</td>
</tr>
<tr>
<td>AT386 xterm</td>
<td>386x</td>
</tr>
<tr>
<td>UnixWare Terminal</td>
<td>386u</td>
</tr>
<tr>
<td>Solaris Intel xterm</td>
<td>386s</td>
</tr>
<tr>
<td>Data General 200</td>
<td>dgd2</td>
</tr>
<tr>
<td>Data General 400</td>
<td>dgd4</td>
</tr>
<tr>
<td>IBM High Function Terminal and aixterm (monochrome)</td>
<td>hft</td>
</tr>
<tr>
<td>IBM High Function Terminal and aixterm (color)</td>
<td>hftc</td>
</tr>
<tr>
<td>hpterm terminal emulator and HP 700/9x terminal</td>
<td>hpterm</td>
</tr>
<tr>
<td>IBM 3151 terminal</td>
<td>3151 (for IBM)</td>
</tr>
<tr>
<td>NCD X Terminal with vt220 style keyboard</td>
<td>ncd220</td>
</tr>
<tr>
<td>Sun cmdtool/shelltool using a type 4 keyboard</td>
<td>sun</td>
</tr>
<tr>
<td>Sun cmdtool/shelltool using a type 5 keyboard</td>
<td>sun5</td>
</tr>
<tr>
<td>vt100 terminal</td>
<td>vt100</td>
</tr>
<tr>
<td>vt220 terminal</td>
<td>vt220</td>
</tr>
<tr>
<td>Wyse 50 or 60 terminal</td>
<td>wy50</td>
</tr>
<tr>
<td>Wyse 150 terminal</td>
<td>wy150</td>
</tr>
<tr>
<td>Sun xterm using a type 4 keyboard</td>
<td>xsun</td>
</tr>
<tr>
<td>Sun xterm using a type 5 keyboard</td>
<td>xsun5</td>
</tr>
</tbody>
</table>
Environment Variables for Client-Only Installations

Set TWO_TASK (Client-Only)

If you are conducting a client-only installation and installing database objects, then set the TWO_TASK environment variable to the correct alias for the database where you want to create the database objects.

**Note:** You must set TWO_TASK for client-only installations. Be sure TWO_TASK is *not* set for server installations.
This chapter describes the installation of Developer/2000, including:

- Using the Oracle Installer
- Respond to Installer Prompts
- Install Online Documentation
- Software Upgrade
- Creating or Upgrading Database Objects

**Attention:** Before beginning this chapter, complete the tasks described in Chapter 2, “Setting the Environment.”
Using the Oracle Installer

The following tasks are covered in this section:

- Mount the Product Installation CD-ROM
- Start the Installer
- Respond to Installer Prompts

Task 1: Mount the Product Installation CD-ROM

To install Developer/2000, you must use the version of the Installer that is supplied on the Oracle Developer/2000 CD-ROM.

Note: In the following instructions, the CD-ROM mount point is referred to as /cdrom. If your mount point is different, substitute the correct mount name point for all references to /cdrom.

Mounting the CD-ROM Manually

To mount your CD-ROM manually, perform the following steps:

1. Log in as root.

   $ su root
   passwd: password
   #

2. Create the mount point directory for mounting the CD-ROM by entering:

   # mkdir /cdrom

3. Mount the CD-ROM to the mount point by entering:

   # mount -p -r -v cdrfs /dev/cd0 /cdrom

   Note: You must have root privileges to mount or unmount the CD-ROM. Be sure to unmount the CD-ROM before removing the CD-ROM from the drive using the amount command.

4. Exit the root account by entering:

   # exit
   $
Task #1: Start the Installer

Perform the following steps to start the Oracle Installer:

1. Log in as oracle software owner.

   WARNING: Do not run the Installer as the root user.

2. Change to the /cdrom/orainst directory by entering the following:
   
   $ cd /cdrom/orainst

3. Execute the following command to invoke the Installer:
   
   In Motif mode, enter:
   
   $ ./orainst /m

   In character mode, enter:
   
   $ ./orainst /c

Oracle Installation

The Oracle installation installs Oracle executables (programs or software) on the system’s hard disk. Certain Oracle products also require database objects which are stored in the database itself. With the RDBMS product, for example, the database objects include those necessary to create a database, such as the system tables and views.

Task 2: Respond to Installer Prompts

The following section describes the main Installer prompts you see when installing Developer/2000 tools and the options you select to perform a new installation. Depending on your installation, the prompts described in this section may not be an exact representation of what you see on the screen.

Installation Activity Choice

The Installer prompts you with three options:

- Install, Upgrade, or De-Install Software

  Select this option to install or upgrade Developer/2000 software. When you select this option, you have the choice to create or upgrade database objects during this session.

- Create/Upgrade Database Objects
Perform Administrative Tasks

Installation Options

*Figure 3–1  Installation Activity Choice Screen*

For new server-based installations, select the *Install New Product* option; however, to upgrade server-based installations, select the *Add/Upgrade Software* option.

For client-only installations, select the *Add/Upgrade Software* option.

You also have the option to build a staging area for installation, install online documentation only, or de-install software. The Migrate from Oracle v6 to Oracle7 option is not applicable to Developer/2000. For more information on these options, select *Help* from the Installation Options screen or see the *Oracle7 Installation Guide for AIX 4.1*.

Select the Install New Product option to install Developer/2000 tools in a new *ORACLE_HOME*. 
**Mount Point**
Enter the mount point (device name) of your Oracle product directory structure. The Installer derives the value of ORACLE_BASE from your answer, assigning it the value `mount_point/app/oracle`.

This screen does not display if you set ORACLE_BASE before starting the Installer.

**Home Locator**
The Installer prompts you to complete the pathname of the ORACLE_HOME directory. The Installer provides you with `$ORACLE_BASE/product/`. If you set ORACLE_BASE before installation, its value is used. If you did not set ORACLE_BASE before installation, the value shown is the OFA-compliant value computed by the Installer. The OFA-compliant path is `$ORACLE_BASE/product/release_number`. Enter the release number of the distribution (for example, 1.6).

This screen does not display if you set ORACLE_BASE and ORACLE_HOME before running the Installer.

**Oracle Directories**
Confirm or change the directory pathnames shown for ORACLE_HOME and ORACLE_BASE.

The values shown are either the values you set before running the Installer or the OFA-compliant values computed by the Installer.
Database Objects
Specify whether to create a database or database objects for the products you are installing.

Installation Log Files
The Installer writes installation log information to the following content-specific files in the $ORACLE_HOME/orainst directory:

- install.log
- sql.log
- make.log
- os.log

If log files already exist in the default location, the Installer asks whether to rename the existing files or to create logs with new names for the current session. Oracle Corporation recommends renaming the existing log files. Logging information from multiple installations in the same files hinders any subsequent debugging.

README.FIRST File
The Installer automatically displays last-minute product updates included in the README.FIRST file.

Skip README File
You can instruct the Installer to skip the README.FIRST in subsequent Installer sessions. The Installer will skip the README.FIRST file until it encounters a newer one; for example, when it is installing a patch.

Oracle sid
If you selected Yes when prompted to create or upgrade database objects, the Installer prompts you to enter your Oracle system identifier (sid).

Install Source
Specify whether you are installing from CD-ROM or from a staging area.

When installing directly from the CD-ROM, you load and install the Oracle distribution in one session. Select this option if you are performing a single installation or if you have insufficient disk space to support a staging area.

If you install from a staging area, you can load and install the distribution in distinct phases. You must choose between temporary and permanent staging areas.
With a temporary staging area, you load the software into a staging area, and the Installer converts the contents into the installed distribution during the Installer session.

A permanent staging area is neither removed nor converted during installation. You can, therefore, use it to perform multiple installations.

**Attention:** Do not attempt to add files to an existing staging area. If it is necessary to recreate a staging area, then you must delete all existing files before using the Installer to create the new one. If you install a software patch from a staging area, then you must create a staging area for just the patch release.

**Note:** Installing from a permanent staging area requires approximately twice the disk space of installing from a temporary staging area or distribution medium. See Chapter 1, “Features and Requirements” for space requirements.

**National Language Support (NLS)**
Use the Installer to specify a language for screen messages from Oracle products with NLS support. Select either All Languages or a language from the displayed list. Installer prompts and messages are always displayed in American English.
Relink Executables
Relinking regenerates a program from its component parts. Even if you decline relinking, the Installer automatically relinks products that require relinking.

Specify relinking if you:
- install a new Oracle protocol adapter
- link Oracle products together
- install user exits
- install patches or bug fixes

Root Install Script File
If an earlier root.sh file exists, then the Installer asks whether to append root-related activities to that file or save the old file as root.sh0 and overwrite root.sh.

Unless you want to run old root.sh activities with the present installation, rename the old file rather than appending the new one.

Install Online Documentation
You can choose to install any or all of:
- online help
- operating system-specific documentation
- product documentation (This documentation is the generic user documentation for Oracle products.)

**Note:** Online documentation installation is not completed by the Installer because the documentation resides on two CD-ROMs. You will complete the online documentation installation by running the startdoc.sh script after completing the Installer session.

**See Also:** Chapter 4, “Completing Developer/2000 Installation”
Software Asset Manager

Figure 3–3 Software Asset Manager Screen

The Software Asset Manager tracks the size of the distribution you selected and the space available in the destination directory (ORACLE_HOME).

Note: Because the Log Installer Action option (under Options) generates a lot of data, you should not select this option unless requested to do so by an Oracle Worldwide Customer Support analyst.

If you chose the Install Documentation Only option in the Installation Options screen, then select the products corresponding to the documentation you are installing. Only the documentation is installed; the products themselves are not installed.

Demonstrations
Decide whether to install the demonstrations for each Developer/2000 product. A separate screen appears for each Developer/2000 product you install.
Interface Choice
Decide whether you will use Motif or character mode for Oracle Book. For Forms, Reports, and Graphics, you may choose to install the Web interface. A separate screen appears for each product.

Software Upgrade
This section describes upgrading from an earlier release of Developer/2000 Release 1 to Release 1.6. It is assumed that Developer/2000 Release 1.0 or 1.3 and Oracle7 Release 7.3.3 are installed in your ORACLE_HOME before you begin upgrading to Release 1.6.

**Note:** Upgrading Developer/2000 to Release 1.6 does not require a Database Object upgrade.

1. Start the Installer as described in “Start the Installer”.
2. At the Installation Activity Choice screen, select the Install, Upgrade, or De-Install Software option. Refer to “Installation Activity Choice”.
3. At the Installation Options screen, select the Add/Upgrade Software option. Refer to “Installation Options”.
4. Continue answering the Installer prompts.
5. At the Software Asset Manager screen, select the products you want to upgrade. For each product you are upgrading, the Installer will prompt you to confirm that you want to delete the old version.

**Note:** Because the Installer prompts you to delete old products, you do not need to de-install Developer/2000 Release 1.0 or 1.3 before upgrading to Release 1.6.
Creating or Upgrading Database Objects

To upgrade server-based installations, restart the Installer and choose the Create/Upgrade Database Objects option from the Installation Activity Choice screen.

For client-installations, see Chapter 2, “Setting the Environment”.

Restart the Installer. Then, from the Installation Activity Choice screen, choose the Create/Upgrade Database Objects option to create new database objects for Developer/2000 or to upgrade database objects from a previous release.
This chapter describes post-installation and configuration tasks for client-only and server-based installations.

- Completing the Online Documentation Installation
- Verifying Your Installation
- Setting Printer Configuration Files
- Setting Up the Developer/2000 Environment
- Setting Up the Character Mode User Environment
- Setting Up the GUI Environment
- Enabling Use of Other Languages
Completing the Online Documentation Installation

During your Installer session, you chose the online documentation you wanted to install, if any. You must now exit the Installer and run a separate script that installs the online documentation.

It is important to remember that the online documents reside on two different CD-ROMs:

- The operating system-specific online documentation is on the Product Installation CD-ROM.
- The online documentation for Oracle products is on the Oracle Product Documentation Library CD-ROM.

UNIX-specific documentation is available in HTML and PDF formats and is installed automatically with Developer/2000 software under the $ORACLE_HOME/orainst/doc directory.

To view the UNIX-specific documentation, cd to the orainst directory on the Developer/2000 CD-ROM and run oraview. If your CD is mounted on /cdrom, cd to /cdrom/oracle/orainst.

To start oraview in Motif GUI mode, enter:

```
./oraview -m -d /cdrom/oracle/orainst/doc
```

In character mode, enter:

```
./oraview -c -d /cdrom/oracle/orainst/doc
```

Product documentation is provided in Oracle Book format.

The following tasks are covered in this section:

- Complete the Installation of Online Documentation
- Prepare Online Documentation for Viewing
- View Online Generic Product Documentation

**Note:** If you chose not to install any online documentation during your Installer session, but you want to view it from CD-ROM, go directly to "Viewing Documentation Directly from CD-ROM" later in this section. If you did not install online documentation and you do not want to view it from CD-ROM, proceed to Chapter 5, “Configuring Oracle Forms”.

---

4-2  Developer/2000 Client/Server Installation Guide for AIX-Based Systems
Task 1: Complete the Installation of Online Documentation

Perform the following steps to complete the installation of product documentation. In the following instructions, it is assumed that your CD-ROM mount point is /cdrom. If it is not, replace all occurrences of /cdrom with your mount point.

1. Install the Oracle UNIX Installer and Documentation Viewer if it is not already installed.
2. If the Installer is still running, select Exit.
3. Go to the $ORACLE_HOME/orainst directory.
   
   $ cd $ORACLE_HOME/orainst

4. Run the startdoc.sh script.
   
   $ ./startdoc.sh

   The script prompts you to mount the Product Documentation Library CD-ROM:

   Please mount the Product Documentation Library CD-ROM.
   --Press enter when done--

   If you chose to install only operating system-specific documentation, the script automatically exits, and you can now proceed to the next task, "Prepare Online Documentation for Viewing".

5. Open a new terminal window.
6. Remove the Product Installation CD-ROM from the CD-ROM drive and replace it with the Product Documentation CD-ROM.
7. Go back to the Press enter when done prompt, and press [Return].
8. Answer the following prompt:

   Enter the CD-ROM mount point: /cdrom

   The startdoc.sh script automatically installs the online product documentation you chose during your Installer session.

Task 2: Prepare Online Documentation for Viewing

Perform the following steps to prepare your online documentation for viewing:

1. Set your ORACLE_HOME environment variable, if it is not already set.
Completing the Online Documentation Installation

2. Change to the $ORACLE_HOME/orainst directory.
   
   $ cd $ORACLE_HOME/orainst

3. Run the fixshelf.sh script.
   
   $ ./fixshelf.sh -d oracle_doc_dir -m operating_system

   Where:
   
   oracle_doc_dir is the directory you specified as $ORACLE_DOC in your Installer session operating_system

   operating_system is your operating system

   The following is an example of a valid entry to run the fixshelf.sh script, where the oracle_doc_dir is /oradoc and where the operating_system is Sun SPARC Solaris:

   $ ./fixshelf.sh -d /oradoc -m solaris2

Task 3: View Online Generic Product Documentation

Online documentation can be installed or viewed from CD-ROM.

Viewing Installed Online Documentation
1. Change to the $ORACLE_HOME/orainst directory.
   
   $ cd $ORACLE_HOME/orainst

2. Run the Oracle Documentation Viewer.

   Motif

   Before running the Oracle Documentation Viewer under Motif or OpenWindows, set the DISPLAY environment variable.

   To run the Oracle Documentation Viewer under Motif or OpenWindows, enter:
   
   $ ./oradocm

   When you run the Oracle Documentation Viewer, the CD Contents Directory will be opened listing the titles of Oracle online documents.

   Character Mode
Completing the Online Documentation Installation

If you are using the Oracle Documentation Viewer in character mode, set your ORACLE_TERM environment variable, if necessary, to support your terminal and keyboard type.

Set the ORACLE_TERM environment variable according to Table 4–1. This determines the key you use to access the Oracle Documentation Viewer menu.

**Table 4–1 Setting the ORACLE_TERM Environment Variable**

<table>
<thead>
<tr>
<th>Terminal/Keyboard</th>
<th>ORACLE_TERM Value</th>
<th>Access Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>An xterm using an hft keyboard</td>
<td>xhft</td>
<td>[F8] or Keypad 0</td>
</tr>
<tr>
<td>An xixterm</td>
<td>hft</td>
<td>[F8] or Keypad 0</td>
</tr>
</tbody>
</table>

To run the Oracle Documentation Viewer in character mode, enter:

```
$ ./oradoc
```

When you run the Oracle Documentation Viewer, the *CD Contents Directory* will be opened listing the titles of Oracle online documents.

3. Select and open the documents you want to view.

**Motif:** Double-click *Select* on the document title.

**Character Mode:** Use the arrow keys to move the cursor to the document title. Press Keypad 0 to access the menu. Press N to bring down the Navigate menu. Press F to issue the Follow link command.

When viewing documents, links exist to other available online documents. These links are always specified by the document title in bold italic font. A document title that is italic but not bold is only text, not a link to another document.

**Viewing Documentation Directly from CD-ROM**

If you have *not* installed online documentation, you can still access it in the following ways:

- Using an HTML browser, you can view your operating system-specific product installation guides, including this document, the *Oracle7 Installation Guide for Sun SPARC Solaris 2.x*, the *Oracle7 Administrator’s Reference for UNIX*, and the *Oracle7 Reference Addendum for Sun SPARC Solaris 2.x*. Instructions for viewing operating system-specific documentation are provided in previous sections of the chapter.
You can view the product documentation on the Product Documentation Library CD-ROM via the CD Contents Directory, using the installed Oracle UNIX Installer and Documentation Viewer. To do this, complete the following steps.

1. Set your ORACLE_HOME environment variable.
2. Install the Oracle UNIX Installer and Documentation Viewer from the Product Installation CD-ROM, if it is not already installed.

   **See Also:** See the instructions earlier in this chapter for more information about installing Oracle products.

3. Mount the Product Documentation Library CD-ROM.
4. Change to the CD-ROM directory where the prefs.ora file is located:

   ```
   $ cd /cdrom/oracle/unix
   ```

5. Customize your prefs.ora file by running the setprefs.sh script:

   ```
   SORACLE_HOME/orainst/setprefs.sh -m /cdrom
   ```

   **WARNING:** The setprefs.sh script will add a new prefs.ora file to your HOME directory. Any existing prefs.ora file in this directory will be copied to prefs.oraO. You may want to save the existing prefs.ora file in your HOME directory before running the setprefs.sh script. It is possible to permanently lose an existing prefs.ora file if you run the setprefs.sh script more than once without saving the original file.

6. Make the prefs.ora file writable.
7. Change to the $ORACLE_HOME/orainst directory:

   ```
   $ cd $ORACLE_HOME/orainst
   ```

8. Run the Oracle Documentation Viewer. See "Viewing Installed Online Documentation" for instructions.

   If you attempt to open an operating system-specific document, you receive the following error message:

   OBV-1081: The file for document Document-ID is not on any bookshelf. Please add this document to a bookshelf and try again.
The Product Documentation Library CD-ROM only contains documentation for Oracle products, not operating system-specific installation documentation. Select OK and choose a product document. For information about viewing operating system-specific online documentation from CD-ROM, see your Product Installation CD-ROM Insert.

Verifying Your Installation

If you have startup problems, use DEBUG_SLFIND to direct error messages to a file of your choice. To do this, set DEBUG_SLFIND to stdout, stderr, or another filename.

Re-run the tool. Check for error messages in the file that indicate a necessary resource file may be missing.
Setting Printer Configuration Files

After running the Oracle Installer, you must set your printer configuration files to prepare your system for printing. To do this, perform the following tasks:

- Locate and Install PPD and AFM Files for Your Printers
- Set Up the Default Printers
- Update the Toolkit Font Mapping File
- Set Printer Commands (Optional)
- Specify a Default Printer
- Information on Printing to HP PCL Printers
- Test Printing Capabilities and Fix Errors

Task 1: Locate and Install PPD and AFM Files for Your Printers

This task provides instructions for choosing an appropriate PostScript Printer Definition (PPD) file for your printer.

Oracle Toolkit uses the PPD files to determine which fonts are available on a specific PostScript printer, since UNIX does not allow the Toolkit to obtain this information from the printer directly. Each PPD file provides paper sizes, available fonts, and default resolution for a particular printer. If this file lists a PostScript font, a corresponding Adobe Font Metrics (AFM) file must exist in the $ORACLE_HOME/guicommon2/tk23/admin/AFM directory since that file is used by the Toolkit to calculate font metrics.

An AFM file specifies font metric information for type 1 font programs. Each AFM file lists the following information about one font: font attributes such as style, weight, width, and character set; whether the font is fixed pitch or proportional; and the size of each character.

Oracle provides PPD and AFM files for some common printers and fonts. If you cannot find the appropriate file for your printer, you can obtain PPD and AFM files from your printer vendor or from Adobe. You can also use the default printer definition file, default.ppd.

1. To find the PPD file for your printer, enter:

   
   ```
   cd $ORACLE_HOME/guicommon2/tk23/admin/PPD
   ls *.ppd | more
   ```

   This will list all of the ppd files which are included with the Oracle distribution.

   ```
2. To determine the fonts that are listed in the PPD file, enter:

   $ grep Font PPD_filename | more

3. To check whether all the necessary fonts are in the
   $ORACLE_HOME/guicommon2/tk23/admin/AFM directory, enter:

   $ cd $ORACLE_HOME/guicommon2/tk23/admin/AFM
   $ ls | more

   **See Also:** Your printer documentation to determine the fonts you
   need for your printer.

---

**Changing the Default PPD File**

You can also specify a PPD file by creating a `default.ppd` that is a copy of
another PPD file to better reflect the local default printer. When an invalid PPD file
is specified for the current printer, for example when an incorrect file is specified or
no file is specified, the Oracle Toolkit uses `default.ppd`.

   $ mv default.ppd default.ppd.old
   $ cp another_PPD_file default.ppd

**Modifying the PPD Files**

Do not modify the PPD files unless you want to add fonts to the printer and you
want these changes reflected in Oracle applications.

If you add fonts to your printer, you should also add entries for these fonts to the
printer’s PPD file.

The format for a font entry is as follows:

*Font font_name: encoding "version" charset

Where:

- `font_name` specifies the Adobe font name as specified in PostScript.
- `encoding` specifies the PostScript encoding name.
- `version` specifies the font’s version number.
- `charset` specifies the Adobe character set name.
Task 2: Set Up the Default Printers

To set up default printers for Developer/2000 products, you need to update the $ORACLE_HOME/guicommon2/tk23/admin/uiprint.txt file with entries for each of your printers. Using this file enables you to obtain correct paper sizes and correct printer resolution. Toolkit application users can now set their print jobs to use various paper sizes available on the selected printer.

Oracle Toolkit uses the uiprint.txt file, located in the $ORACLE_HOME/guicommon2/tk23/admin directory, to display the list of printers available on your system. Each printer is defined by a line in the uiprint.txt file containing five fields separated by colons.

For each of your printers, enter the following line into the uiprint.txt file:

```
printer:printer_driver:Toolkit_driver:printer_descr:printer_descr_file:
```

Where:

- **printer** contains the name of the printer, as used with `lpr` or `lp` commands. This parameter also specifies the default printer if both the ORACLE_PRINTER and PRINTER environment variables are not set on your UNIX system.

- **printer_driver** specifies the type of print driver used for the printer. The Toolkit currently supports the PostScript, ASCII, and PCL selections for the printer driver.

- **Toolkit_driver** specifies the version of the printer driver that should be used by the Toolkit. Currently, the Toolkit supports 1 for ASCII or Level 1 PostScript, 2 for Level 2 PostScript printers, and 5 for HP PCL printers.

- **printer_descr** contains a free-format description of the printer. It can show, for example, the location and speed of the printer to make the user’s choice easier.

- **printer_descr_file** specifies the printer definition file to be used with the printer. The format of this file is dependent on the driver specified for the printer. At present, the Toolkit supports the Adobe PPD and the HP HPD file formats. See “Locate and Install PPD and AFM Files for Your Printers” for complete instructions.

**Attention:** The first non-commented line (line without a number in column one) must define a valid printer. Printing services and saving output to file may not work properly unless the uiprint.txt file is configured properly.
Task 3: Update the Toolkit Font Mapping File

The `uifont.ali` file contains alias mappings from one Toolkit font to another, and is used to map unavailable fonts to substitutes. For example, the Arial font is found only on Microsoft Windows and is mapped to Helvetica on UNIX.

The `uifont.ali` file resides in the `$ORACLE_HOME/guicommon2/tk23/admin` directory. If you want to use another directory, see the following section.

---

**See Also:** Comments in the `uifont.ali` file. This file is updated for each new release.

---

Set the TK23_FONTALIAS Environment Variable

Oracle Toolkit first looks for `uifont.ali` in the location specified by TK23_FONTALIAS. If TK23_FONTALIAS is not set, or if `uifont.ali` is not in the specified location, the Toolkit looks for `uifont.ali` in the `$ORACLE_HOME/guicommon2/tk23/admin` directory.

Modify the `uifont.ali` File

If you want to modify the `uifont.ali` file, make sure that the general structure of each line is as follows:

```
new font=existing font
```

Where:

- `new_font` is a font you want to add.
- `existing_font` is a font that already exists on your printer.

The specific format of each line in `uifont.ali` is as follows:

```
face.size.style.weight.width.charset = face.size.style.weight.width.charset
```

Where the values are separated by periods (.) and:

- `face` specifies the name of the font the Toolkit uses for printing. Common fonts include Palatino, Helvetica, Courier, and Times.
- `size` specifies the size of the font in points.
- `style` specifies the choice of style options, which are plain, italic, oblique, underline, outline, shadow, inverted, and overstrike. If there is more than one style, the list must be enclosed in parentheses, for example, (plain italic).
The following rules apply:

- Any Arial that has both italic and overstrike styles maps to a 12-point font. Each font line may be continued to the next line by using the backslash (\).
- Separate each element from the next by a period (.).
- Combine styles, if necessary, using the plus sign (+) to delimit parts of a style. For example:
  

  maps any Helvetica 12-point font that has both italic and overstrike styles to a 12-point, bold, italic Helvetica font.

- Use quotes to enclose element names that contain a space. For example:
  

  maps any Avant Garde font that has both italic and overstrike styles to a 12-point, bold, italic Helvetica font.

- Use the correct number of periods as placeholders if you choose not to define certain elements. Trailing periods may be truncated. For example, in the following statement the two sides are equivalent even though the size is not specified on the left side:
  
  Arial..Italic+Overstrike = Helvetica.12.Italic.Bold

**Task 4: Set Printer Commands (Optional)**

You can set TK2_PRINT to store the print command and TK2_PRINT_STATUS to store the printer status command. The print string is similar to printf() in the C programming language, because you can embed the following strings:
Where:

\%

is the name of the printer.

\%

is the number of copies (printed as a decimal number).

If you do not set TK2_PRINT, the value defaults to:

```
lp -s -d '%n' -n%c
```

If you do not set TK2_PRINT_STATUS, the value defaults to:

```
/usr/bin/lpstat -p '%n'
```

To set TK2_PRINT and TK2_PRINT_STATUS for the Bourne shell, enter:

```
$ TK2_PRINT= "your_print_string" ; export TK2_PRINT
$ TK2_PRINT_STATUS= "your_print_string" ; export TK2_PRINT_STATUS
```

For the C shell, enter:

```
% setenv TK2_PRINT "your_print_string"
% setenv TK2_PRINT_STATUS "your_print_string"
```

**Task 5: Specify a Default Printer**

Developer/2000 determines your default printer by searching for values of the following variables in the given order:

- TK2_PRINTER
- ORACLE_PRINTER
- PRINTER
- the first entry in your uiprint.txt file

To specify a default printer, set TK2_PRINTER to the applicable printer.

---

**Note:** The default printer must be specified in one of the ways listed above; otherwise, printing services and saving output to file may be disabled.

---

**Task 6: Information on Printing to HP PCL Printers**

With Developer/2000, printing to HP PCL printers is fully supported, in addition to PostScript and ASCII. Similar to PPD files for PostScript printers, HPD or HP glue files provide information on what fonts are available for an HP PCL printer.
Many HP glue files are provided under $ORACLE_HOME/guicommon2/tk23/admin/HPD. HP’s AutoFont Support Installer (available on PCs) generates these files automatically. Documentation for their file format is available in HP’s PCL5 Developer’s Guide.

As with PostScript’s AFM files, every HP font must have an associated TFM file; TFM files should be provided by the font vendor, and new fonts should be added to the glue file for your printer when installed. The TFM files are located under $ORACLE_HOME/guicommon/2/tk23/admin/TFM.

For any new font, you must specify these fields in the glue file:

```
FONT={fontname}
{fontname} is a descriptive name for the font.

/tfm={tfm-filename}
{tfm-filename} is the base filename for TFM file.
```

You can also specify these fields in the glue file, after the "FONT=" field, if the TFM file isn’t specific enough:

```
/ptsize={size {size ...}}
```

If the font is a bitmapped font, but is listed in the TFM file as a scalable font, you can limit the point sizes used by listing all acceptable sizes.

```
/symset={symset {symset ...}}
```

This field limits the supported symbol sets to those listed on the field. See the HP PCL documentation for a list of recognized symbol sets.

Developer/2000 now also supports the ‘defaultpaper’ field for printing to PCL format. This field can be used to set the defaultpaper to be used by the Toolkit. The format of this field is:

```
<defaultpaper={papername}
```

For example, `<defaultpaper=A4` will set the default paper to A4.

The papername is case insensitive. If the user specifies this field in more than one place, then the final defaultpaper field’s papername will be used as the defaultpaper. If the user has specified a defaultpaper and the papername is not supported by the printer, then the defaultpaper setting will be ignored and the defaultpaper will be set to LETTER. Also, if the papername specified in this field is incorrect, then the defaultpaper will be set to LETTER.
**Task 7: Test Printing Capabilities and Fix Errors**

1. Test printing capability.
   
   Start up any Developer/2000 tool and print to the default printer.

2. Select a printer from the Choose Printer dialog.
   
   The Choose Printer dialog lists printers available on your system, giving the type and a full description of each. Oracle Toolkit obtains this list from the `$ORACLE_HOME/guicommon2/tk23/admin/uiprint.txt` file. Users can choose a printer from the list of available printers.

   Users can also specify a new printer and its type. To choose a new printer, enter its name, or choose a corresponding type from the Choose Printer dialog containing the different drivers supported by Oracle Toolkit. The Toolkit checks to see if the name corresponds to a valid printer. If the printer is valid, Oracle Toolkit allows the user to associate a PPD file with the printer through a file dialog. If the user does not want to associate a PPD file, the Toolkit uses `default.ppd`.

---

**Setting Up the Developer/2000 Environment**

This section describes how to set up the generic user environment for Developer/2000. The environment variables below are required to run Developer/2000, regardless of the chosen user interface (character mode, or Motif).

**Task 1: Set ORA_NLS33 and ORA_NLS32**

With Developer/2000 Release 1.6, you are required to set the ORA_NLS33 environment variable to be `$ORACLE_HOME/ocommon/nls/admin/datad2k`. This is the directory where the NLS33 data files are installed during the installation of Developer/2000.
Example of ORA_NLS33 setting

For the Bourne shell, enter:

```
% ORA_NLS33=$ORACLE_HOME/ocommon/nls/admin/datad2k
% export ORA_NLS33
```

For the C shell, enter:

```
% setenv ORA_NLS33 $ORACLE_HOME/ocommon/nls/admin/datad2k
```

By default, the NLS32 data files are installed under the $ORACLE_HOME/ocommon/nls/admin/data directory. If you have not moved these files from their default directory, you will not be required to set the ORA_NLS32 environment variable. If you have moved them, you will need to set ORA_NLS32 to the new location of the NLS32 data files.

Example of ORA_NLS32 setting

Assume the NLS data files have been moved from their default location to $ORACLE_HOME/ocommon/nls/admin/new_data.

For the Bourne shell, enter:

```
% ORA_NLS32=$ORACLE_HOME/ocommon/nls/admin/new_data
% export ORA_NLS32
```

For the C shell, enter:

```
% setenv ORA_NLS32 $ORACLE_HOME/ocommon/nls/admin/new_data
```
Setting Up the Character Mode User Environment

This section explains how to set up the character mode user environment for Developer/2000.

Perform the following tasks to set up the character mode user environment:

- Determine Your Terminal Resources
- Set ORACLE_TERM

Task 1: Determine Your Terminal Resources

This section helps you decide whether you need to set the ORACLE_TERM environment variable.

**Note:** You must set ORACLE_TERM if TERM is not already set to the device name of a supported terminal. If you do not properly set either TERM or ORACLE_TERM, the Developer/2000 character mode tools cannot start up.

Check the value of TERM by entering:

```
$ echo $TERM
```

Refer to the "Supported Terminals" section to determine whether TERM is already set to the device name of one of the supported terminals.

**TERM Set**

If TERM is already set to a supported device, you do not need to set ORACLE_TERM, and you are finished setting your terminal resources.

**TERM Not Set**

If TERM is not already set, do not reset TERM.

If you are using a supported terminal, set ORACLE_TERM to the corresponding device name before using any of the Developer/2000 character mode tools. See "Set ORACLE_TERM" for instructions.

Task 2: Set ORACLE_TERM

Before setting ORACLE_TERM, determine the device name for ORACLE_TERM using the list of device names provided in "Supported Terminals".
Set the ORACLE_TERM environment variable to point to the appropriate terminal file before you begin using Developer/2000. This should be done for each user after installation.

Setting ORACLE_TERM overrides the default UNIX environment variable TERM for Oracle tools. The value of TERM, however, remains the same.

If ORACLE TERM is set to an invalid or non-existent device, the function keys cannot perform the appropriate operations, and you may not be able to start up Developer/2000.

**Supported Terminals**

The following table lists device names to which you can set ORACLE TERM and the corresponding terminal filenames that the character mode Developer/2000 tools use. Oracle Toolkit v2 terminal files are located in the $ORACLE_HOME/guicommon2/tk23/admin/terminal/US directory.

Many of the tools also require their own terminal files, such as fmrcansi.res to be used with tk2cansi.res for Forms. Check the product-specific chapters for a list of these files. For these Developer/2000 tools to work, both files must exist.

<table>
<thead>
<tr>
<th>Device Name</th>
<th>Terminal</th>
<th>Terminal File Names Used by Oracle Terminal</th>
</tr>
</thead>
<tbody>
<tr>
<td>3151</td>
<td>IBM 3151 terminal</td>
<td>tk2c3151.res</td>
</tr>
<tr>
<td>386</td>
<td>AT386 console</td>
<td>tk2c386.res</td>
</tr>
<tr>
<td>386u</td>
<td>AT386 UnixWare Terminal (xterm with line-drawing support)</td>
<td>tk2c386u.res</td>
</tr>
<tr>
<td>386x</td>
<td>AT386 xterm</td>
<td>tk2c386x.res</td>
</tr>
<tr>
<td>386s</td>
<td>Solaris x86 xterm</td>
<td>tk2c386s.res</td>
</tr>
<tr>
<td>ansi</td>
<td>ANSI terminals for SCO</td>
<td>tk2cansi.res</td>
</tr>
<tr>
<td>avx3</td>
<td>AviiON avx-300 terminal</td>
<td>tk2cavx3.res</td>
</tr>
<tr>
<td>dgd2</td>
<td>Dasher 200 series (DG)</td>
<td>tk2cdgd2.res</td>
</tr>
<tr>
<td>dgd4</td>
<td>Dasher 400 series (DG)</td>
<td>tk2cdgd4.res</td>
</tr>
<tr>
<td>hft</td>
<td>IBM High Function Terminal and aixterm (monochrome)</td>
<td>tk2chft.res</td>
</tr>
</tbody>
</table>
## Table 4–2  Supported Terminals for Character Mode Developer/2000 Tools

<table>
<thead>
<tr>
<th>Device Name</th>
<th>Terminal Description</th>
<th>Terminal File Names Used by Oracle Terminal</th>
</tr>
</thead>
<tbody>
<tr>
<td>hftc</td>
<td>IBM High Function Terminal and aixterm (color)</td>
<td>tk2chftc.res</td>
</tr>
<tr>
<td>hp</td>
<td>hpterm terminal emulator and HP 700/9x terminals</td>
<td>tk2chp.res</td>
</tr>
<tr>
<td>iris</td>
<td>SGI IRIS console</td>
<td>tk2ciris.res</td>
</tr>
<tr>
<td>ncd</td>
<td>NCD X Terminal with vt220-style keyboard</td>
<td>tk2cnccd.res</td>
</tr>
<tr>
<td>sun</td>
<td>Sun cmdtool Type 4 keyboard</td>
<td>tk2csun.res</td>
</tr>
<tr>
<td>sun5</td>
<td>Sun cmdtool Type 5 keyboard</td>
<td>tk2csun5.res</td>
</tr>
<tr>
<td>tandm</td>
<td>Tandem ANSI terminal</td>
<td>tk2ctandm.res</td>
</tr>
<tr>
<td>vt100</td>
<td>DEC vt100 terminal (or emulator, including xterm)</td>
<td>tk2cvt100.res</td>
</tr>
<tr>
<td>vt220</td>
<td>DEC vt220 terminal (or emulator, including xterm)</td>
<td>tk2cvt220.res</td>
</tr>
<tr>
<td>wy150</td>
<td>Wyse 150 terminal</td>
<td>tk2cwy150.res</td>
</tr>
<tr>
<td>wy50</td>
<td>Wyse 50 or 60 terminals</td>
<td>tk2cwy50.res</td>
</tr>
<tr>
<td>xhft</td>
<td>IBM High Function Terminal xterm</td>
<td>tk2cxhft.res</td>
</tr>
<tr>
<td>xsun</td>
<td>Sun xterm Type 4 keyboard</td>
<td>tk2cxsun.res</td>
</tr>
<tr>
<td>xsun5</td>
<td>Sun xterm Type 5 keyboard</td>
<td>tk2cxsun5.res</td>
</tr>
</tbody>
</table>
Setting Up the GUI Environment

This section explains how to prepare the GUI environment for Developer/2000:

- Relocate Key Definition File
- Set Up the X Window System and Motif Environments

Getting Help with X and OSF/Motif

In this section, it is assumed you have a working knowledge of X Window and OSF/Motif setup and administration, including an understanding of the client/server architecture of the X Window System and Motif.

**Note:** Oracle customers can contact Oracle Technical Support regarding any problems with Oracle products. However, Oracle Corporation does not offer technical support for the X Window System or Motif provided by your operating system vendor. Refer your questions about the X Window System or Motif to your on-site expert, or to your operating system vendor or Motif vendor.

---

**Note:** Oracle does not support PC Xserver emulators. If you are having a problem with an emulator on a PC, see if you can duplicate the problem on your server’s console.

---

Task 1: Relocate Key Definition File

When installation is complete, the X11 key symbol file XKeysymDB is in the 
$ORACLE_HOME/guicommon2/tk23/admin directory. You must move the XKeysymDB file to the /usr/openwin/lib/X11 directory on every machine on which Developer/2000 is running. To move the file, perform the following steps:

1. As the root user, change to the $ORACLE_HOME/guicommon2/tk23/admin directory.

   # cd $ORACLE_HOME/guicommon2/tk23/admin

2. Set up the XKeysymDB file of your choice.

   If you already have this file, decide whether to use the new file as is or merge it with the old file. If you decide to use the new file, you may want to rename the old file to preserve it.
If the directory `/usr/lib/X11` does not exist, create it by entering:

```bash
# mkdir /usr/lib/X11
```

- To preserve the original file, enter:

  ```bash
  # cd /usr/lib/X11
  # mv XKeysymDB XKeysymDB.OLD
  # cd $ORACLE_HOME/guicommon2/tk23/admin
  ```

- To install only the new file, enter:

  ```bash
  # cp XKeysymDB /usr/lib/X11
  ```

- To merge the new file with the existing file, add the old material you want to keep into the new file using your system editor.

**Note:** The application code reads the `XKeysymDB` file at startup time. If the application code cannot find the file, or if it does not contain all of the relevant OSF `keysym` values, some function keys may not function properly. In this case you may receive warning messages similar to the following:

```plaintext
Warning: translation table syntax error: Unknown keysym
name: osfUp
Warning: ...found while parsing `<Key>osfUp:
ManagerGadgetTraverseUp ()`
```

3. Exit the root user account.

Oracle Motif applications running in an X11R4 environment do not have the capability of locating National Language Support (NLS) data files. Except for this limitation, Oracle Motif applications running in an X11R4 environment have the same capability as applications running in an X11R5 environment.

**Task 2: Set Up the X Window System and Motif Environments**

This section describes the following topics:

- Set the `DISPLAY` Environment Variable
- Control Display Access with the `xhost` Utility
Set the DISPLAY Environment Variable

If you run Developer/2000 on a machine that is not your local workstation, set the DISPLAY environment variable on the remote machine to the name of your X Windows screen. This tells the application which machine, server, and screen to display its windows.

The format for the name of the X Windows screen is:

```
machine_name : server.screen
```

Where:

- `machine_name` specifies the name of the machine you will be using.
- `server` specifies the sequential code number for the server.
- `screen` specifies the sequential code number for the screen (optional).

For example, your workstation is named `bambi`, and you want to run Motif Forms from a larger machine named `godzilla`. From `godzilla`:

For the Bourne shell, enter:

```
$ DISPLAY=bambi:0.0; export DISPLAY
```

For the C shell, enter:

```
% setenv DISPLAY bambi:0.0
```

The first zero in this example refers to the first server running on `bambi`. The second zero refers to the first screen managed by that server. Typically, there is just one server and one screen per workstation or X terminal. In such cases you can omit the screen specification.

Control Display Access with the xhost Utility

Most X servers prevent users on other machines from displaying windows on your screen, unless you explicitly give them permission. This is done by means of an access file `/etc/Xn.hosts`, where `n` is the number of the display. The `xhost` utility allows you to interactively grant or deny systems access to the server.

To grant access to a remote system, run `xhost` and specify the name with an optional leading plus sign (+). To deny access, use a leading minus sign (-). A plus sign without a host name gives access to all available systems, whether they are listed in `/etc/Xn.hosts` or not. A minus sign without a host name restricts access to systems listed in the `/etc/Xn.hosts` file.
Running `xhost` without arguments prints the list of hosts in the `/etc/Xn.hosts` file, and tells you whether they have current access to your display.

For example, your workstation is named `bambi` and you want to grant access to `godzilla`, a remote machine. On `bambi`, enter:

```
$ xhost +godzilla
```

To allow unlimited, unspecified access, enter:

```
$ xhost +
```

**Attention:** When you grant another machine access, all users of that machine have access to your machine’s X server. For example, if you grant machine `godzilla` access to `bambi`, all users of `godzilla` have access to the `bambi` X server.

---

**Enabling Use of Other Languages**

This section explains how to set up your environment so that you can run the tools using various languages.

Perform the following tasks to enable Developer/2000 to run in languages other than the default language (English):

- Set NLS_LANG
- Set Tk2Motif*fontMapCs

**Note:** Forms and Graphics runtime files may need to be regenerated if they were previously generated with a different NLS_LANG setting.

---

**Task 1: Set NLS_LANG**

Developer/2000 products use the NLS_LANG environment variable to determine which language territory and terminal character set to use. To set NLS_LANG, use the following procedure.

For the Bourne shell, enter:

```
$ NLS_LANG=language_territory.character_set
$ export NLS_LANG
```

For the C shell, enter:
Enabling Use of Other Languages

% setenv NLS_LANG language_territory.character_set

Where:

language is a supported language.

territory is a supported territory.

character_set is a character set supported by the user’s terminal

Note: If NLS_LANG is not set, the default setting is us7ascii.

Table 4–3 provides values supported by Developer/2000 products for NLS_LANG:

<table>
<thead>
<tr>
<th>Language Name</th>
<th>language Value</th>
<th>Territory Name</th>
<th>territory Value</th>
<th>character_set Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>American</td>
<td>american</td>
<td>United States</td>
<td>america</td>
<td>us7ascii</td>
</tr>
<tr>
<td>Dutch</td>
<td>dutch</td>
<td>The Netherlands</td>
<td>“the netherlands”</td>
<td>we8dec</td>
</tr>
<tr>
<td>French</td>
<td>french</td>
<td>France</td>
<td>france</td>
<td>we8dec</td>
</tr>
<tr>
<td>German</td>
<td>german</td>
<td>Germany</td>
<td>germany</td>
<td>we8dec</td>
</tr>
<tr>
<td>Italian</td>
<td>italian</td>
<td>Italy</td>
<td>italy</td>
<td>we8dec</td>
</tr>
<tr>
<td>Japanese</td>
<td>japanese</td>
<td>Japan</td>
<td>japan</td>
<td>ja16euc</td>
</tr>
<tr>
<td>Korean</td>
<td>korean</td>
<td>Korea</td>
<td>korea</td>
<td>ko16ksc5601</td>
</tr>
<tr>
<td>Spanish</td>
<td>spanish</td>
<td>Spain</td>
<td>spain</td>
<td>we8dec</td>
</tr>
<tr>
<td>Traditional</td>
<td>“traditional”</td>
<td>China</td>
<td>zhp</td>
<td>zht32euc</td>
</tr>
<tr>
<td>Chinese</td>
<td>chinese</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Task 2: Set Tk2Motif*fontMapCs

This section explains how to add an entry to the Tk2Motif file so that the Toolkit can match Oracle character sets with X character sets. The setting is called Tk2Motif*fontMapCs. Add the following line to the file to set Tk2Motif*fontMapCs:

Tk2Motif*fontMapCs: xset=character_set
Where:

- $xset$ is the name of an X character set.
- $character\_set$ is the name of an Oracle character set.

To get a list of all character sets available on your X Server, enter:

```
$ xlsfonts | awk -F' ' '{print $14 "-" $15}' | sort -u
```

The Oracle character set is the last item in the NLS_LANG setting. For example, for the Swedish language, the Oracle character set name is $we8dec$. 

This chapter explains how to configure and use the Motif and character mode versions of Forms release 4.5 on your UNIX system.

The topics covered in this chapter are:

- Product Documentation
- Administering Forms
- Using Forms

**Note:** For Motif users, there may be more font choices available in release 4.5 than were available in previous releases.
Product Documentation

For information on the general use of Forms, see the following documents:

- *Forms Developer's Guide*: Part# A32505
- *Forms Advanced Techniques*: Part# A32506
- *Forms Reference Manual*: Part# A32507
- *Getting Started with Forms*: Part# A32504
- *Forms Messages and Code*: Part# A32508

Online Help

This release provides the of45h.obd online help file for Forms. You can find this file in the $ORACLE_HOME/forms45/admin/help/US directory.

To access online help using Oracle Book Motif, enter:

$ runbook22m filename

relnotes.txt File

The relnotes.txt file is located in the $ORACLE_HOME/guicommon2/doc directory. This document notes differences between Developer/2000 Release 1.6 and its documented functionality. This includes changes that were made too late to be included in the documentation, as well as any known limitations.
Administering Forms

Executables

Table 5–1 contains the Forms executable names. The executables also appear in the $ORACLE_HOME/bin directory.

<table>
<thead>
<tr>
<th>Component</th>
<th>Executable Name on UNIX</th>
<th>Platform-Independent Executable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Motif</td>
<td>Char Mode</td>
</tr>
<tr>
<td>Designer</td>
<td>f45desm</td>
<td>n/a</td>
</tr>
<tr>
<td>Generator</td>
<td>f45genm</td>
<td>f45gen</td>
</tr>
<tr>
<td>Runform</td>
<td>f45runm</td>
<td>f45run</td>
</tr>
<tr>
<td>Runform with debugger</td>
<td>f45runmd</td>
<td>n/a</td>
</tr>
<tr>
<td>Forms listener</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Forms server</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Note:** Forms Designer and the Runform with debugger are not available in character mode.

Edit Preferences

Options is a menu item on the Forms Designer Tools menu. The Options menu item sets options for your Forms session. It displays the Options dialog box, in which you specify Designer and Runtime options.
Source File Locations

If no directory is specified, Forms searches for its product files in the following locations in this order:

- the current directory
- directories specified by FORMS45_PATH
- directories specified by ORACLE_PATH

Setting UNIX Environment Variables

This section describes the environment variables you need to use Forms:

- FORMS45_PATH
- FORMS45_TERMINAL
- ORACLE_TERM
- TMPDIR
- TK23_ICON

See Also: The complete list of generic environment variables in “Set Required Environment Variables”.

FORMS45_PATH

FORMS45_PATH specifies the search path for image files, forms files, and menus.

FORMS45_TERMINAL

FORMS45_TERMINAL points to the directory where the terminal files for Forms reside.

ORACLE_TERM

If the TERM environment variable is not already set to a supported device name, you must set ORACLE_TERM before logging into Forms to use the character mode implementation of the runform component. The ORACLE_TERM environment variable setting overrides the TERM environment variable setting.

Set the ORACLE_TERM environment variable to the appropriate terminal type. See Table 5–2 for a list of device names to which you can set the ORACLE_TERM environment variable.
You can also override the TERM and ORACLE_TERM environment variable settings from the command line by entering:

```
$ runform45 TERM=terminal:device
```

This table provides information on the supported environment settings and the terminal files located in the `forms45/admin/terminal/US` directory.

### Table 5–2  Supported Terminals for Character Mode Forms

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Device Name</th>
<th>Terminal Description</th>
<th>Terminal File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>hft</td>
<td>hft</td>
<td>IBM hft mono console</td>
<td>fmarchft.res</td>
</tr>
<tr>
<td>iris</td>
<td>iris</td>
<td>SGI IRIS console (xterm using SGI keyboard)</td>
<td>fmirciris.res</td>
</tr>
<tr>
<td>sun5</td>
<td>sun5</td>
<td>Sun Type 5 console (cmdtool)</td>
<td>fmrcsun5.res</td>
</tr>
<tr>
<td>sun</td>
<td>sun</td>
<td>Sun Type 4 console (cmdtool)</td>
<td>fmrcsun.res</td>
</tr>
<tr>
<td>3151</td>
<td>3151</td>
<td>IBM 3151 terminal</td>
<td>fmrc3151.res</td>
</tr>
<tr>
<td>vt100</td>
<td>vt100</td>
<td>vt100 terminal</td>
<td>fmrcvt100.res</td>
</tr>
<tr>
<td>vt220</td>
<td>vt220</td>
<td>vt220 terminal</td>
<td>fmrcvt220.res</td>
</tr>
<tr>
<td>xhft</td>
<td>xhft</td>
<td>IBM hft xterm (xterm using HFT keyboard)</td>
<td>fmrcxhft.res</td>
</tr>
<tr>
<td>xsun</td>
<td>xsun</td>
<td>Sun Type 4 xterm (xterm using SUN keyboard)</td>
<td>fmrcxsun.res</td>
</tr>
<tr>
<td>xsun5</td>
<td>xsun5</td>
<td>Sun Type 5 xterm (xterm using SUN keyboard)</td>
<td>fmrcxsun5.res</td>
</tr>
</tbody>
</table>

**TMPDIR**

The TMPDIR environment variable establishes the directory in which you store Forms temporary files. The default directory is `/tmp`.

**TK23_ICON**

If set, TK23_ICON points to the path where the icon files for your application reside.
Using Forms

Starting Forms Runtime

Forms Runtime allows the user to run applications created in Forms Designer.

To start the Motif mode version of Forms Runtime, enter:

$ runform45m filename

To start the debug Motif version of Forms Runtime, enter:

$ runform45md filename

Where filename is the name of your form. If you do not enter the name of a file, a main menu appears from which you can open a form.

See Also: The Forms Developer’s Guide for more information on the debug runtime and the Forms Reference Manual for a description of available command line parameters.

To start the character mode version of Forms Runtime, enter:

$ runform45 filename

Where filename is the name of your form.

Note: There is no debug Forms Runtime in character mode.

Starting Forms Designer

Forms Designer allows the application developer to build dynamic forms applications using graphs, reports, images, and PL/SQL programs to interpret database information. To start Forms Designer, enter:

$ oraform45m

Moving Motif Windows

Under Motif, all windows are movable. This is true even if the user does not set the movable hint in the windows property sheet.
User Exits

See Chapter 12, “Creating User Exits” for information on how to create user exits in Forms.

Demonstration Files and Applications

The following Motif demonstration files are located in the $ORACLE_HOME/forms45/demos directory.

You must set the following environment variables to properly generate and run the Forms demonstrations.

Table 5–3 Required Environment Variables

<table>
<thead>
<tr>
<th>Environment Variable</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>TK23_ICON</td>
<td>$ORACLE_HOME/forms45/demos/icons</td>
</tr>
<tr>
<td>FORMS45_PATH</td>
<td>$ORACLE_HOME/forms45/demos/start $ORACLE_HOME/forms45/plsqllib</td>
</tr>
<tr>
<td>FORMS45_UNKNOWN</td>
<td>Points to the directory where your Tk2Motif.rgb file resides.</td>
</tr>
</tbody>
</table>

Synchronization Demonstration

This demonstration highlights the automatic synchronization of multiple layouts of the same data. You can change the data in any of the layouts, and corresponding values are mirrored without writing a single line of code.

The file included is sync.fmb.

To run the demonstration, perform the following steps:

1. Generate the synchronization module by entering:
   
   genform45m sync scott/tiger

2. Run the demonstration by entering:
   
   runform45m sync scott/tiger
Using Forms

**Toolbar Demonstration**
This demonstration illustrates the use of an iconic toolbar and how you can use it to navigate through the data in a form. In addition, this demonstration uses the current row attribute to highlight the current row of a multi-record block, if the block contains data.

The files included are `toolbar.fmb` and `toolbar.pll`.

To run this demonstration, perform the following steps:

1. Generate the toolbar module by entering:
   ```
   genform45m toolbar scott/tiger
   ```
2. Run the demonstration by entering:
   ```
   runform45m toolbar scott/tiger
   ```

**Drag Demonstration**
This demonstration gives an example of how to implement drag and drop in an application using the EMP/DEPT tables. The application is based on a library called `drag.pll`, which provides generic code on how to drag one or multiple objects in an application.

The files included are `drag.fmb` and `drag.pll`.

To run this demonstration, perform the following steps:

1. Generate the drag module by entering:
   ```
   genform45m drag scott/tiger
   ```
2. Run the demonstration by entering:
   ```
   runform45m drag scott/tiger
   ```
**Oracle Chess Demonstration**

The files included are: `chess.fmb`, `chess.mmb`, `chess.pll`, `chess.sql`, `king.ico`, `queen.ico`, `bishop.ico`, `knight.ico`, `rook.ico`, `pawn.ico`. To run this demonstration, perform the following steps:

1. Install the required tables by running the `chess.sql` script as `scott/tiger`.
2. Generate the chess module by entering:
   ```bash
   $ genform45m chess scott/tiger
   $ genform45m chess scott/tiger module_type=menu
   ```
   The TK23_ICON or ORACLE_ICON environment variables must be set to the directory that includes the six icon files. The icon files reside in the `$ORACLE_HOME/forms45/demo/icons` directory.
3. Run the demonstration by entering:
   ```bash
   $ runform45m chess scott/tiger
   ```

**Game of 4othello Demonstration**

The file included is `4othello.fmb`. To run this demonstration, perform the following steps:

1. Generate the `4othello` module by entering:
   ```bash
   $ genform45m 4othello scott/tiger
   ```
2. Run the demonstration by entering:
   ```bash
   $ runform45m 4othello scott/tiger
   ```
This chapter explains how to configure and use the character mode and Motif versions of Reports release 2.5 on your UNIX-based operating system.

The topics covered in this chapter are:

- Product Documentation
- Administering Reports
- Using Reports
Product Documentation

For information on the general use of Reports, see the following documents:

- Reports Enhancements Manual: Part# A32487
- Building Reports Manual: Part# A32488
- Reports Reference Manual: Part# A32489
- Reports Messages and Codes Manual: Part# A32490
- Reports Runtime Manual: Part# A32493
- Reports Migration Manual: Part# A32491
- Reports Documentation Addendum: Part# A32492

relnotes.txt File

The relnotes.txt file is located in the $ORACLE_HOME/guicommon2/doc directory. This document notes differences between Developer/2000 Release 1.6 and its documented functionality. This includes changes that were made too late to be included in the documentation, as well as any known limitations.
Administering Reports

Executables

The Reports executables, listed in the following table, initially appear in the $ORACLE_HOME/bin subdirectory.

<table>
<thead>
<tr>
<th>Component</th>
<th>Executable Name on UNIX</th>
<th>Platform-Independent Executable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Reports</td>
<td>r25convm (Motif)</td>
<td>convrep25m (Motif)</td>
</tr>
<tr>
<td>Move Reports and Printer</td>
<td>r25mrepm (Motif)</td>
<td>moverep25m (Motif)</td>
</tr>
<tr>
<td>Definitions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runtime</td>
<td>r25run (char mode)</td>
<td>runrep25 (char)</td>
</tr>
<tr>
<td></td>
<td>r25runm (Motif)</td>
<td>runrep25m (Motif)</td>
</tr>
<tr>
<td>Designer</td>
<td>r25desm (Motif)</td>
<td>orarep25m (Motif)</td>
</tr>
</tbody>
</table>

**Note:** Reports Designer is not available in character mode.

**Note:** The executables for converting reports (r25convm) and moving reports and printer definitions (r25mrepm) are available in Motif mode only. If you need to run these executables in a character mode environment, you must set the BATCH parameter to YES. See the Reports Reference Manual for more information on executables.
When you enter an executable on the command line, it generally has the following form:

```
$ executable keyword1=value1 keyword2=value2
```

Where:

- `keyword` is not case-sensitive. Set `keyword` equal to a `value` to construct the argument on the command line.
- `value` is the value of the `keyword`. The values for the keywords `source`, `dest`, `cmdfile`, `term`, `desname`, `desformat`, `dname`, and `sname` are case-sensitive. This means the value specified for these keywords must be in the same case as the corresponding filename.

**See Also:** The Executables chapter in the Reports Reference Manual for more information about arguments.

### Relinking Reports

In Release 1.6, Graphics is linked into the Reports executables automatically. There is no longer an option to relink Reports without Graphics.

To relink Reports, enter the following:

```
$ cd $ORACLE_HOME/reports25/lib
```

For Developer/2000 Client/Server, enter:
```
$ make -f ins_reports25d.mk install
```

### Edit Preferences

Tools Options is a menu item on the Reports Tools menu. This menu item sets options for your Reports session. It displays the Tools Options dialog box, in which you specify, design, and run preferences.

Use Save Preferences to store the user preferences you defined using Tools Options. The preferences are merged with those that existed when you started Reports. They are stored in `$HOME/prefs.ora`. 
Report Doc Option

Use the Report Doc option, which is accessed from the Administration submenu of the File Menu, to create a list of the settings of reports if the reports are stored in the database. Report Doc is useful for keeping a record of all your reports and for debugging reports. To perform Report Doc in batch mode, use runrep to run one of the three available reports on reports. The reports are located in the $ORACLE_HOME/reports25/admin/report directory. The following examples show how to use Report Doc in batch mode with a report.

Motif portrait output:

$ runrep25m report=srwdocpb.rdf userid=username \
   batch=yes report_name=name_of_user’s_report destype=file

Motif landscape output:

$ runrep25m report=srwdoclb.rdf userid=username \
   batch=yes report_name=name_of_user’s_report destype=file

Character portrait output:

$ runrep25m report=srwdocpc.rdf userid=username \
   batch=yes report_name=name_of_user’s_report destype=file

Text Format Filename Extension

When a report definition is saved in text format, a .rex filename extension is appended to the filename. For example, if you saved the report definition emp.rdf in ASCII format, the file would be named emp.rex.
Call Interface

Using the information in the Reports Reference Manual, and the supplied makefile, $ORACLE_HOME/reports25/lib/reports25w.mk, you can generate executable programs that contain Reports calls. Perform the following steps:

1. Create a program that contains a call to a function in the Reports call interface, such as rwccon(), rw2con(), rwcmov(), rw2mov(), rwcrrb(), rw2rrb(), rwcrun(), rw2run(), rwcsrb(), rw2srb().

2. Compile the program and generate object code.

3. To link the demonstrations of call interface for Reports, enter the following commands:

   cd $ORACLE_HOME/reports25/lib

   ■ For character mode runtime, enter:
     $ make -f ins_reports25w.mk r25runo

   ■ For bitmap runtime, enter:
     $ make -f ins_reports25w.mk r25runmo

   ■ For bitmap designer, enter:
     $ make -f ins_reports25w.mk r25desmo

Attention: If you have the Developer/2000 Client/Server only release, replace ins_reports25w.mk with ins_reports25d.mk for the above commands.
4. To link your own call interface executables, enter the following commands:

   For character mode runtime, enter:
   
   $ make -f ins_reports25w.mk r25runo RXOCIQA="ociobj1.o ociobj2.o..."
   
   For bitmap runtime, enter:
   
   $ make -f ins_reports25w.mk r25runmo RXOCIQA="ociobj1.o ociobj2.o..."
   
   For bitmap designer, enter:
   
   $ make -f ins_reports25w.mk r25desmo RXOCIQA="ociobj1.o ociobj2.o..."

   **Attention:** If you have the Developer/2000 Client/Server only release, replace ins_reports25w.mk with ins_reports25d.mk for the above commands.

#### Filename Extensions

The files you create with Reports have the following extensions: .pll, .prt, .rdf, .rep, and .rex.

- .pll: a PL/SQL library
- .prt: contains an ascii readable report definition which cannot be executed
- .rdf: contains a complete report definition which can be executed
- .rep: contains a binary, non-editable report definition
- .rex: a printer definition file

These file extensions are case-sensitive and, therefore, must be specified in lowercase.

**See Also:** The Storage chapter in the Reports Reference Manual for a description of each file extension.
Online Tools for Administration

Reports is shipped with several SQL scripts with which you can quickly perform certain database administration tasks, such as adding reports tables to your database and controlling privileges.

**See Also:** The Administration chapter in the Reports Reference Manual for a complete list.

Printer Definitions

These printer and terminal definitions are used for character mode reports.

The printer definition files are in the $ORACLE_HOME/reports25/admin/printer directory. The following set of printer definitions is shipped with your UNIX-based system:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bold.prt</td>
<td>A generic printer file that supports bold attributes and 66x80 page size</td>
</tr>
<tr>
<td>dec.prt</td>
<td>A generic printer file for most DEC printers; it supports 66x80 page sizes for the LN03, LPS40, LP05, and LA50 printers</td>
</tr>
<tr>
<td>dec180.prt</td>
<td>Same as decland.prt, but supports 66x180 page size</td>
</tr>
<tr>
<td>decland.prt</td>
<td>A generic printer file that prints in landscape mode and supports 66x132 page sizes</td>
</tr>
<tr>
<td>decwide.prt</td>
<td>Same as dec.prt, but supports 66x132 page size</td>
</tr>
<tr>
<td>dflt.prt</td>
<td>A generic printer file that ignores highlighting attributes and supports 66x80 page size</td>
</tr>
<tr>
<td>hpl.prt</td>
<td>A generic printer file for the HP LaserJet printer that supports 66x80 page size</td>
</tr>
<tr>
<td>hplwide.prt</td>
<td>Same as hpl.prt, but supports 66x80 page sizes</td>
</tr>
<tr>
<td>no_ff.prt</td>
<td>A generic printer file with no formfeed between pages and supports 66x80 page size</td>
</tr>
<tr>
<td>ps1132.prt</td>
<td>Character mode PostScript printer file that prints in landscape mode and supports 66x132 page size</td>
</tr>
<tr>
<td>ps1180.prt</td>
<td>Character mode PostScript printer file that prints in landscape mode and supports 66x180 page size</td>
</tr>
<tr>
<td>ps2page.prt</td>
<td>Character mode PostScript printer file that prints two 66x80 portrait pages on one landscape page</td>
</tr>
</tbody>
</table>
Modifying the Tk2Motif File

Enter the following in your Tk2Motif.rgb file to ensure proper font sizing regardless of the display resolution setting:

Oracle Reports Designer*fontUseDpi: True
Oracle Reports Runtime*fontUseDpi: True

Setting UNIX Environment Variables

This section describes the environment variables you need to use Reports:

- **REPORTS25_TERMINAL**
- **REPORTS25_PATH**
- **ORACLE_TERM**
- **REPORTS25_TMP**
- **TK23_TERMINAL**
- **TK23_ICON**

A directory specifies the directory where a file resides. A path specifies the colon-delimited list of directories where a file can reside.

**See Also:** The complete list of generic environment variables in “Set Required Environment Variables”.

**REPORTS25 TERMINAL**

If set, REPORTS25 TERMINAL points to the directory where the terminal files for Reports reside.

- **psland.prt** character mode PostScript printer file that prints in landscape mode and supports 66x80 page size
- **psp132.prt** character mode PostScript printer file that prints in portrait mode and supports 66x132 page size
- **psport.prt** PostScript printer file that prints in portrait mode and supports 66x80 page size
- **wide.prt** a generic printer file that ignores highlighting attributes and supports 66x132 page size
- **wide180.prt** same as wide.prt, but supports 66x180 page sizes
**REPORTS25_PATH**

REPORTS25_PATH locates external objects that you use in your reports.

**ORACLE_TERM**

To use the character mode implementation, you must set ORACLE_TERM before logging into Reports.

You can also override the ORACLE_TERM environment variable setting from the command line by entering:

```
$ r25run TERM=device
```

You can find the Reports terminal file for your UNIX-based system in the $ORACLE_HOME/reports25/admin/terminal/US directory. The Reports terminal file you need is used with the Toolkit terminal file.

For example, if your terminal is a vt100, the Reports terminal file, rwcvt100.res, works together with the corresponding Toolkit terminal file, tk2cvt100.res.

Set the ORACLE_TERM environment variable to the appropriate terminal type. See Table 6–2 for a list of device names to which you can set the ORACLE_TERM environment variable.
Table 6–2 provides information on the supported environment settings and the files located in the reports25/admin/terminal/US directory.

### Table 6–2 Supported Terminals for Character Mode Reports

<table>
<thead>
<tr>
<th>ORACLE_TERM (Devise)</th>
<th>Terminal Description</th>
<th>Terminal File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>hft</td>
<td>IBM hft console</td>
<td>rwichft.res</td>
</tr>
<tr>
<td>hftc</td>
<td>IBM hft color console</td>
<td>rwichftc.res</td>
</tr>
<tr>
<td>iris</td>
<td>Iris (term using SGI keyboard)</td>
<td>rwciris.res</td>
</tr>
<tr>
<td>vt100</td>
<td>vt100 (or emulator, including xterm)</td>
<td>rwcvt100.res</td>
</tr>
<tr>
<td>vt220</td>
<td>vt220 (or emulator, including xterm)</td>
<td>rwcvt220.res</td>
</tr>
<tr>
<td>xhp</td>
<td>hp xterm emulator and HP 700/9x terminals</td>
<td>rwcxhp.res</td>
</tr>
<tr>
<td>dgd2</td>
<td>Data General Dasher 200 terminal</td>
<td>rwcgd2.res</td>
</tr>
<tr>
<td>dgd4</td>
<td>Data General Dasher 400 terminal</td>
<td>rwcgd4.res</td>
</tr>
<tr>
<td>xsun</td>
<td>Sun Type 4 xterm (xterm using SUN keyboard)</td>
<td>rwcxsun.res</td>
</tr>
<tr>
<td>xsun5</td>
<td>Sun Type 5 xterm (xterm using SUN keyboard)</td>
<td>rwcxsun5.res</td>
</tr>
<tr>
<td>386</td>
<td>386 console</td>
<td>rwc386.res</td>
</tr>
<tr>
<td>386x</td>
<td>386 xterm</td>
<td>rwc386x.res</td>
</tr>
<tr>
<td>386u</td>
<td>386 UnixWare</td>
<td>rwc386u.res</td>
</tr>
</tbody>
</table>
REPORTS25_TMP
REPORTS25_TMP establishes the directory where Reports will store Reports temporary files. The default directory is /tmp.

TK23_TERMINAL
If set, TK23_TERMINAL points to the directory where the terminal definition file for the terminal type you are using resides.

TK23_ICON
If set, TK23_ICON points to the path where icons which you use in your Reports reside.

Specifying Printers and Queues
The script $ORACLE_HOME/reports25/admin/printer/spoolcmd.sh is called when you send a file to the printer. By default, the script uses lpr to print if /usr/ucb/lpr has been installed on your system; otherwise, the script uses lp. If your printer setup is different, or if you want to always use lp, you may need to modify this file.
Using Reports

Starting Reports Runtime

Reports Runtime allows you to run reports built in the Designer.

To start the Motif mode version of Reports Runtime, enter:

$ runrep25m filename

Where filename is the name of your report. If you do not enter the name of a file, a
main menageries where you can specify a report name and database connect string.

To start the character mode version of Reports Runtime, enter:

$ runrep25 filename

Where filename is the name of your report.

Starting Reports Designer

Reports Designer allows you to build reports to use with Reports. To start Reports
Designer, enter:

$ orarep25m

Printing Reports

Choosing a Printer

To choose a printer from Reports:

1. Select File—>Choose Printer to display the Printer Chooser dialog box.

2. Select the printer and specify any other desired options by choosing
   File—>Page Setup. Your specifications here override any DESNAME parameter
   used when invoking reports from the command line.

   See Also: Setting Printer Configuration Files

Sending Reports to Printers

Before printing your report, you should select the appropriate printer and any
applicable options.

To send reports to a printer:
1. Choose File→Run. The Runtime Parameter Form is displayed. Now set the DESTYPE to Printer.

2. Choose Run Report. The Print dialog box is displayed.

3. Specify the print range and the number of copies and select OK.

   **Note:** No bit-mapped printer definition files are shipped with Reports. Printer definition files are used with character-mode reports only.

---

**Sending Reports to Files**

Before printing your report to a file, you should select the appropriate printer driver and any applicable options.

To print to a file, complete the steps below:

1. Select the applicable printer driver via File→Print Setup.

2. Select File→Run or File→Print. The Runtime Parameter Form is displayed.

3. Select File for DESTYPE.

4. Specify the complete path and filename in the DESNAME field, then select Run Report.

   If you do not specify a value for DESNAME, Reports uses the default name <report name>.LIS. If you do not specify a directory path, Reports saves the report output to the current directory.

5. The Print dialog box is displayed with Print to File checked. Select OK.

---

**Sending Reports through Mail**

To send reports through mail:

1. Select Mail from the Destination Type pop-up menu.

2. Enter the user ID of the recipient in the text field.


The default mail type is UNIX mail. You can send reports through a different mail system, such as Oracle Office, by editing the r25mail.sh file, located in $ORACLE_HOME/reports25/admin/mail. The r25mail.sh file provides instructions and examples of how to set up Reports to send reports through different mail systems.
Creating ASCII Output

You can print reports to an ASCII file or a non-PostScript printer. To create ASCII output, complete the following steps:

1. Select File—>Choose Printer to display the Printer Chooser dialog box, select the Reports ASCII Driver, and select OK. If MODE=CHARACTER for the report, you can skip this step.

2. Select File—>Print.

3. To print to a file, change the DESTYPE to File, specify the name of the ASCII file in the DESNAME field, and select Run Report.

   **Note:** To send the report output directly to the printer, go to the Printers dialog in the File menu. Select the Reports ASCII Driver, then select Connect. Select the correct printer port for your machine and accept the dialogs. When running the report, change the DESTYPE to Printer and select Run Report. Then, select OK from the Print dialog box.

Motif Compliance

All menu elements in the GUI mode version of Reports are Motif-compliant across all UNIX-based systems.

Escape to Host

To specify the UNIX shell which is used when Escaping to a Host prompt, make certain your UNIX SHELL environmental variable is set to the name of the appropriate shell command interpreter.

Set SHELL for the Bourne shell, enter:

```
$ SHELL=/bin/sh
$ export SHELL
```

To set SHELL for the C shell, enter:

```
% setenv SHELL /bin/csh
```

User Exits

See Chapter 12, “Creating User Exits” for information on creating user exits in Reports.
Demonstration Files and Applications

The $ORACLE_HOME/reports25/demo directory contains the demonstration files. Following are the procedures for installing the Reports demonstration tables:

1. Create a user ID to store the demonstration tables in the database. For example, enter the following commands:

   sqlplus system/manager
   SQL> GRANT connect, resource
   2> TO user
   3> IDENTIFIED BY passwd;

2. Go to the reports25/demo/reqfiles directory.

   $ cd reports25/demo/reqfiles

3. Enter the following to load the demonstration tables:

   $ sqlplus user/password @demobld
   $ sqlplus user/password @advanced

   For report demonstration files, set REPORTS25_PATH to $ORACLE_HOME/reports25/demo/reqfiles. Go to the reports/25/demo(bitmap directory and enter:

   $ runrep25m report_name userid=user/password

   Additional demonstration reports may be included in the reports25/demo/char directory. These are documented in the Building Reports Manual.
This chapter explains how to configure and use the Motif and character mode versions of Graphics release 2.5 on your UNIX-based operating system.

The topics covered in this chapter are:

- Product Documentation
- Administering Graphics
- Using Graphics
Product Documentation

The information in this chapter supplements the information provided in:

- *Graphics 2.5 Developer’s Guide*: Part# A32482

Online Help

This release provides the following online help files for Graphics:

- god.obd (Graphics Designer Help)
- gor.obd (Graphics Runtime Help)

They are located in the `$ORACLE_HOME/graphics25/admin/help/US` directory.

To access online help using Oracle Book Motif, enter:

```
$ runbook22m filename
```

relnotes.txt File

The `relnotes.txt` file is located in the `$ORACLE_HOME/guicommon2/doc` directory. This document notes differences between Developer/2000 Release 1.6 and its documented functionality. This includes changes that were made too late to be included in the documentation, as well as any known limitations.
Administering Graphics

Executable Files

The Graphics executables listed in Table 7–1 are installed in the $ORACLE_HOME/bin subdirectory.

<table>
<thead>
<tr>
<th>Component</th>
<th>Name on UNIX</th>
<th>Platform-Independent Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Designer</td>
<td>g25desm</td>
<td>oragraph25m</td>
</tr>
<tr>
<td>Runtime</td>
<td>g25runm</td>
<td>rungraph25m</td>
</tr>
<tr>
<td>Batch</td>
<td>g25batm</td>
<td>batgraph25m</td>
</tr>
</tbody>
</table>

If the g25batm executable fails, make sure that:

- The uiprint.txt file contains a valid printer entry, and/or the PRINTER environment variable is set to a valid printer.
- If either /dev/audio or /dev/audioctl are present, these files are writable.

**Note:** Oracle Graphics currently attempts to initialize sound system at startup (including batch).

Edit Preferences

Tools Option is a selection on the Tools menu that sets options for your Graphics session. It displays the Tools Option dialog box, in which you specify design-time and runtime preferences.
Runtime Parameters

When you enter an executable on the command line, it generally has the following form:

$ executable_name keyword1=value1 keyword2=value2

Each keyword=value statement is called an argument. The keyword= portion of all arguments is not case-sensitive. However, the value portion of all arguments except userid, print, copies, close, and quit is case-sensitive.

Example

If you save a display as Untitled, and you want to see a runtime execution of the display, enter:

$ rungraph25m openfile=Untitled
Using Graphics

Setting UNIX Environment Variables

This section describes the environment variables you need to use Graphics:

- GRAPHICS25_PATH
- ORACLE_PATH
- SQLLIB_PATH

A path specifies the colon-delimited list of directories where your Graphics applications reside.

See Also: The complete list of generic environment variables in “Set Required Environment Variables”.

GRAPHICS25_PATH

GRAPHICS25_PATH specifies where Graphics searches for .ogd files and other files used by the .ogd, such as PL/SQL libraries (.pli files), SQL queries (.sql files), and imported files.

ORACLE_PATH

ORACLE_PATH specifies where Oracle tools search for files.

SQLLIB_PATH

SQLLIB_PATH specifies the path for PL/SQL libraries.

Starting Graphics Runtime

Graphics Runtime allows an end-user to run applications created in the designer. To start Graphics Runtime, enter:

$ rungraph25m filename userid/password

Where filename is the name of your application. If you do not enter the name of a file, a main menu appears from which you can open a document.
Starting Graphics Designer

Graphics Designer allows the application developer to build dynamic graphical displays using charts, graphics, images, sounds, and PL/SQL programs to interpret database information.

To start Graphics Designer, enter:

$ oragraph25m

User Exits

See Chapter 12, “Creating User Exits” for information on how to create user exits in Graphics.
This chapter explains how to configure Procedure Builder Release 1.5 on your UNIX-based operating system.

The topics covered in this chapter are:

- Product Documentation
- Administering Procedure Builder
- Using Procedure Builder
Administering Procedure Builder

Executables

The executables appear in the $ORACLE_HOME/bin subdirectory. The Procedure Builder executable is listed in Table 8–1.

<table>
<thead>
<tr>
<th>Component</th>
<th>Executable Name on UNIX</th>
<th>Platform-Independent Executable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runtime</td>
<td>de15desm</td>
<td>plbild15m</td>
</tr>
</tbody>
</table>

Setting UNIX Environment Variables

- ORAPLSQLLOADPATH

See Also: The complete list of generic environment variables in “Set Required Environment Variables”.

ORAPLSQLLOADPATH

The ORAPLSQLLOADPATH environment variable tells Procedure Builder the path to look for PL/SQL files.

A path specifies the colon-delimited list of directories where a file can reside.
Using Procedure Builder

Starting Procedure Builder Runtime

To start the Motif mode version of Procedure Builder Runtime, enter:

$ plbild15m filename

To start the line mode version of Procedure Builder Runtime, enter:

$ plbild15m filename mode=line
This chapter explains how to configure Browser version 2.0 on your UNIX-based operating system.

The topics covered in this chapter include:

- **Product Documentation**
- **Installing the Browser Client**
- **Installing the Browser Database Tables**

**Note:** Browser is a graphical client, and only runs on UNIX under the Motif graphical user interface.
Product Documentation

The information provided in this chapter supplements the following Browser Version 2.0 documentation:

- Browser User's Guide: Part# A32682
- Browser Reference Manual: Part# A32057
- Browser System Administrator's Guide: Part# A33058

Online Help and Documentation

The online help files brw20.obd (Browser) and bra20.obd (Browser Administrator's Utility) can be viewed from within Browser using the context-sensitive and menu-searchable features provided by Oracle Help. You can also view these files using Oracle Book. The help files are located in the $ORACLE_HOME/browser20/admin/help/US directory.

To access online help or online documentation using Oracle Book for Motif, enter:

$ runbook22m filename
Installing the Browser Client

Executable File

The Browser executables are installed in the $ORACLE_HOME/bin subdirectory. The Browser executable names are listed in the following table:

<table>
<thead>
<tr>
<th>Component</th>
<th>Executable Name on UNIX</th>
<th>Platform-Independent Executable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser User Edition</td>
<td>brw20</td>
<td>browser20m</td>
</tr>
<tr>
<td>Browser Extended Edition</td>
<td>brwe20</td>
<td>browser20em</td>
</tr>
<tr>
<td>Browser Administrator’s Utility</td>
<td>brwa20</td>
<td>browser20am</td>
</tr>
</tbody>
</table>

Default Font and Color

Browser uses the standard OSF/Motif Toolkit2 conventions for font and color. See Appendix A, “Configuring Toolkit Resources”, for more information about font and color.
Installing the Browser Database Tables

Running the SQL Upgrade and Installation Scripts Manually

Attention: Before running any script, particularly the End User Layer (EUL) scripts, make sure the working directory is set to $ORACLE_HOME/browser20.

There are four SQL scripts, run as system, provided with Browser that are run on the server:

- **brwupg20.sql** upgrades Browser 1.0 system file tables to Browser 2.0.
- **brwins20.sql** creates the tables that enable you to save queries in the database.
- **brwprf20.sql** installs the Browser Profile table (to control Data and Schema editing).
- **brwble20.sql** builds the End User Layer tables.

You may not need to run all of these scripts, depending on whether you are upgrading from Browser 1.0 or intend to use the Data and Schema Editors or the Administrator’s Utility.

Note: If you are upgrading from Browser 1.0, run the brwupg20.sql script instead of running the brwins20.sql script.

Upgrading from Browser 1.0 to 2.0

Run the brwupg20.sql script, located in the admin directory, to upgrade from Browser 1.0 to 2.0. In particular, it creates the browser_docs_sql table and other new 2.0 tables. It does not change the browser_docs table.

You only need to run this script if you are upgrading from Browser 1.0 to 2.0. Browser 2.0 can read Browser 1.0 queries regardless of whether you run this script; but, this script builds the tables that enable you to save queries in the database.
Allowing Users to Save Queries in the Database

Run the `brwins20.sql` script as the SYSTEM user to create the necessary tables to save queries in the database. There are two main tables: `BROWSER_DOCS_`, which stores all the information about a query, and `BROWSER_GRANTS_`, which stores security information (privileges).

You need to run this script only if you plan to allow users to save queries to the database. This script does not affect any other Browser functions.

The advantage of running this script is that if you provide users the ability to save queries to the database, these queries can be made available to other users. Browser creates a view based on any query saved in the database, which can be queried just like a table. Refer to the Performing Administration Tasks section in Chapter 1 of the Browser System Administrator’s Guide for details.

---

**Attention:** If you are upgrading from Browser 1.0, run the `brwupg20.sql` script instead of running the `brwins20.sql` script.

Creating the Browser Profile Table

To create the Browser Profile table, run the `brwprf20.sql` script as the SYSTEM user. The Browser Profile table is used to control Data and Schema editing, Browser Administrator Utility use, Set Roles privilege use, and End User Layer access. The Schema Editor, Data Editor, Set Roles, and Administrator Utility are disabled if this table is not present, whereas both the End User Layer and Native dictionaries are enabled by default.

This script has no impact on Browser other than to load the Browser Profile table. See the Performing Administration Tasks section in Chapter 1 of the Browser System Administrator’s Guide for details.
Editing the Browser Profile Table+

The `brwprf20.sql` script assigns all Browser profile privileges to the SYSTEM user by default. For other users or roles to have these privileges, you must edit this table (insert the appropriate rows into the table). The following are the privileges controlled by the Profile table:

<table>
<thead>
<tr>
<th>Privileges</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator Privileges for End-User Layer</td>
<td>Disabled</td>
</tr>
<tr>
<td>Data Editing Privileges</td>
<td>Disabled</td>
</tr>
<tr>
<td>Schema Editing Privileges</td>
<td>Disabled</td>
</tr>
<tr>
<td>End-User Dictionary Table Access</td>
<td>Enabled</td>
</tr>
<tr>
<td>Native Dictionary Table Access</td>
<td>Enabled</td>
</tr>
<tr>
<td>Set Role Privileges</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

The following example shows how to enable all privileges for a user called BROWSER. You can use SQL*Plus or the Browser Data Editor to edit the profile table. To use the Browser Data Editor:

1. Connect as the SYSTEM user
2. From the Data menu, select the Data Table BROWSER_PROFILE
3. SELECT PRODUCT, USERID, ATTRIBUTE, CHAR_VALUE FROM BROWSER_PROFILE
4. Execute the query
5. From the Data Menu, select Show Data Editor
6. From the Edit Menu, select Insert
7. Enter 6 as the number of rows
8. Enter the following values:

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>USERID</th>
<th>ATTRIBUTE</th>
<th>CHAR_VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser</td>
<td>BROWSER</td>
<td>BROWSER_ADMIN</td>
<td>ENABLED</td>
</tr>
<tr>
<td>Browser</td>
<td>BROWSER</td>
<td>DATA_EDIT</td>
<td>ENABLED</td>
</tr>
</tbody>
</table>
9. From the Data Menu, select Commit Data.

To edit the Browser profile table using SQL*Plus instead of the Browser Data Editor, connect as the SYSTEM user, and execute the following SQL statements:

```sql
SQL> INSERT INTO browser_profile VALUES ('Oracle Browser','BROWSER','BROWSER_ADMIN', null,null,'ENABLED',null,null);

SQL> INSERT INTO browser_profile VALUES ('Oracle Browser','BROWSER','DATA_EDIT', null,null,'ENABLED',null,null);

SQL> INSERT INTO browser_profile VALUES ('Oracle Browser','BROWSER','SCHEMA_EDIT', null,null,'ENABLED',null,null);

SQL> INSERT INTO browser_profile VALUES ('Oracle Browser','BROWSER','NATIVE_DICTIONARY', null,null,'ENABLED',null,null);

SQL> INSERT INTO browser_profile VALUES ('Oracle Browser','BROWSER','ENDUSER_DICTIONARY', null,null,'ENABLED',null,null);

SQL> INSERT INTO browser_profile VALUES ('Oracle Browser','BROWSER','SET_ROLES', null,null,'ENABLED',null,null);

SQL> COMMIT;
```

---

**Table 9-3 Values for Browser Data Editor**

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>USERID</th>
<th>ATTRIBUTE</th>
<th>CHAR_VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser</td>
<td>BROWSER</td>
<td>SCHEMA_EDIT</td>
<td>ENABLED</td>
</tr>
<tr>
<td>Browser</td>
<td>BROWSER</td>
<td>NATIVE_DICTIONARY</td>
<td>ENABLED</td>
</tr>
<tr>
<td>Browser</td>
<td>BROWSER</td>
<td>ENDUSER_DICTIONARY</td>
<td>ENABLED</td>
</tr>
<tr>
<td>Browser</td>
<td>BROWSER</td>
<td>SET_ROLES</td>
<td>ENABLED</td>
</tr>
</tbody>
</table>
Installing the End User Layer (EUL) Tables

To install the EUL tables, run the `brwble20.sql` script as SYSTEM user. The script creates a new user, who becomes the owner of the End User Layer.

**Attention:** Before running this script, make sure you run the `brwprf20.sql` script, which creates the Browser Profile table. Refer to “Creating the Browser Profile Table” for more information.

1. The `brwble20.sql` script prompts you to specify the name of the user who will own the EUL. The script then prompts you for your password.

2. The script prompts you to enter a tablespace name. The default is SYSTEM.

3. The script prompts you to specify the end_user_layer_connect_string. Make sure you type the entire string. For example, enter:

   ```
eulowner:eulowner@aliasname
   ```

   Where:
   - `eulowner` is the username you specified.
   - `aliasname` is a SQL*NET v2 alias specified in your `tnsnames.ora` file.

4. The script prompts you to indicate whether you want to use PUBLIC synonyms. The default answer is Yes (Y).

Make sure you update the Browser Profile table to give BROWSER_ADMIN privileges to any other users who need to use the Administrator’s Utility. See the Editing the Browser Profile Table section, or Performing Administration Tasks in Chapter 1 of the Browser System Administrator’s Guide for details.

**See Also:** The Understanding SQL*Net 2.3 manual.

EUL Issues

To make the EUL accessible to a user, the following criteria must be met:

- Private Synonyms or Public Synonyms must be created for the user by running either `eulpris.sql` or `eulpubs.sql` as system.

- The ENDUSER_DICTIONARY attribute must be ENABLED in the BROWSER_PROFILE table (it is enabled by default).
The NATIVE_DICTIONARY attribute is optional. However, if it is enabled, and you want to access the EUL, you need to enter DICTIONARY = ENDUSER as either a Command Line option or through the Preferences dialog (accessed from the Browser Data menu) before running Browser.

If any of these criteria is not met, you will not be able to access the EUL.

**Building Demonstration Tables Manually**

The tutorial in the *Browser User’s Guide* uses sample data that resides in your Oracle7 Server database. The demonstrations described in this document may differ from the samples you see on your screen.

You need to only build the demonstration tables once. If you want to install demonstration tables automatically, the Installer provides this option with a prompt during installation.

To build the demonstration tables manually, perform the following steps:

1. Create a new account in the database with the username **browser** and the password **browser**.
2. Build the sample tables using the `brwbld20.sql` script. Enter the following commands at the system prompt:

   ```
   $ cd $ORACLE_HOME/browser20/demo
   $ sqlplus browser/browser @brwbld20.sql
   ```

   Where **browser** is the username and also the password. Do not try to use a different username or password. If you are a remote user, append your network connect string to the **browser** username.

**Dropping Demonstration Tables**

To drop the demonstration tables, use the `brwdrp20.sql` script. Enter the following at the system prompt:

```
$ cd $ORACLE_HOME/browser20/demo
$ sqlplus browser/browser @brwdrp20.sql
```
This chapter explains how to administer Oracle Book release 2.2 on your UNIX-based operating system.

The topics covered in this chapter are:

- Product Documentation
- Administering Oracle Book
- Using Oracle Book
Product Documentation

The information in this chapter supplements the information provided in:

- Oracle Book User’s Guide: Part# A311269
- Oracle Book Designer’s Guide: Part# A31267
- Oracle Book Designer’s Tutorial: Part# A31268
- Oracle Book SGML Designer’s Guide: Part# A31266

Online Help

This release provides the product documentation as the online help files for Oracle Book.

You can find the following file in the $ORACLE_HOME/book22/doc directory:

- tutorial.obd file (Designer’s Tutorial)

You can find the following files in the $ORACLE_HOME/book22/admin/help/US directory:

- book.obd (User’s Guide)
- bookdes.obd (Designer’s Tutorial)
- cnv.obd (Converting Oracle Book V1.0 to V2)

To access online help using Oracle Book Motif, enter:

$ runbook22m filename

README.doc File

The README.doc file, located in the $ORACLE_HOME/book22/doc directory, provides a list of changes to Oracle Book since the last release. This file outlines administrative procedures and describes known restrictions.

The ob2html.doc file, located in the same directory, provides information on installing the HTML converter component.
Administering Oracle Book

Executables

The executables appear in the $ORACLE_HOME/bin subdirectory. The Oracle Book executables are listed in the following table.

<table>
<thead>
<tr>
<th>Component</th>
<th>Executable Name on UNIX</th>
<th>Platform-Independent Executable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runtime</td>
<td>b22runm (Motif) b22run (char.mode)</td>
<td>runbook22m runbook22</td>
</tr>
<tr>
<td>Designer</td>
<td>b22desm</td>
<td>orabook22m</td>
</tr>
<tr>
<td>Converter</td>
<td>b22convm</td>
<td>convbook22m</td>
</tr>
<tr>
<td>HTML Converter</td>
<td>ob2htmlm</td>
<td>book22tohtmlm</td>
</tr>
</tbody>
</table>

Preference File

Users can modify information in the default.obs file located in their home directory, as defined in the UNIX /etc/passwd file, to suit their own particular requirements. Administrators can place a global copy of this file in $ORACLE_HOME/book22/admin.

Setting UNIX Environment Variables

This section describes the environment variables you need to run Oracle Book:

- BOOK2_DIR
- ORACLE_TEMP
- ORACLE_TERM

See Also: The complete list of generic environment variables in “Set Required Environment Variables”.
**BOOK2_DIR**
BOOK2_DIR tells Oracle Book where to look for documents not found in the local directory.

**ORACLE_TEMP**
ORACLE_TEMP establishes the directory in which Oracle Book stores temporary files. The default directory is the user’s home directory.

**ORACLE_TERM**
If the TERM environment variable is not already set to a supported device name, you must set ORACLE_TERM before logging into Oracle Book to use the character mode implementation of the runbook component. The ORACLE_TERM environment variable setting overrides the TERM environment variable setting. See “Supported Terminals for Character Mode Oracle Book” for a list of device names to which you can set ORACLE_TERM.

The following table provides information on the supported environment settings and the terminal files located in the book22/admin/terminal/US directory.

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Device Name</th>
<th>Terminal Description</th>
<th>Terminal File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>vt100</td>
<td>vt100</td>
<td>vt100 terminal</td>
<td>obcvt100.res</td>
</tr>
<tr>
<td>vt220</td>
<td>vt220</td>
<td>vt220 terminal</td>
<td>obcvt220.res</td>
</tr>
<tr>
<td>hft</td>
<td>hft</td>
<td>IBM hft mono console</td>
<td>obchft.res</td>
</tr>
<tr>
<td>xhft</td>
<td>xhft</td>
<td>IBM hft xterm (xterm using hft keyboard)</td>
<td>obcxhft.res</td>
</tr>
<tr>
<td>xsun</td>
<td>xsun</td>
<td>Sun xterm using type 4 keyboard</td>
<td>obcxsun.res</td>
</tr>
<tr>
<td>xsun5</td>
<td>xsun5</td>
<td>Sun xterm using type 5 keyboard</td>
<td>obcxsun5.res</td>
</tr>
</tbody>
</table>
Using Oracle Book

Starting Oracle Book Runtime

Oracle Book Runtime allows you to view documents online.

To start the Motif version of Oracle Book Runtime, enter:

$ runbook22m filename

To start the character mode version of Oracle Book Runtime, enter:

$ runbook22 filename

Where filename is the name of your document. If you do not enter the name of a file, a main menu appears from which you can open a document.

Starting Oracle Book Designer

Oracle Book Designer allows you to build documents for use with Oracle Book. To start Oracle Book Designer, enter:

$ orabook22m filename

Where filename is the name of your Oracle Book build file. If you do not enter the name of a file, a main menu appears from which you can open a document.

Starting Oracle Book Converter

Oracle Book Converter changes Oracle Book version 1 source files into Oracle Book version 2 source files. To start Oracle Book Converter, enter:

$ convbook22m filename

Where filename is the name of your Oracle Book version 1 build file. If you do not enter the name of a file, a main menu appears from which you can open a document.
Starting Oracle Book HTML Converter

Oracle Book HTML Converter changes Oracle Book source files into HTML source files. To start Oracle Book HTML Converter, enter:

$ book22tohtmlm filename htmldir

Where:

filename is the Oracle Book document.

htmldir is the directory where you want your HTML files to reside.

Demonstration File

Demonstration files are located in the $ORACLE_HOME/book22/demo directory.

To run the Oracle Book demonstrations, enter the following commands:

$ cd $ORACLE_HOME/book22/demo
$ runbook22m hawaii.obd
$ runbook22m context.obd

The demonstration is a document describing Developer/2000 and related products. To navigate through it, either click on product names, or use the Navigate menu.
The Motif Integrated Demonstration for Developer/2000 Release 1.6 illustrates how Forms, Reports, and Graphics interact as an integrated product set. All three products must be installed for the demonstration to run.

**Note:** The Integrated Demonstration only runs in English.
The Integrated Demonstration for Developer/2000

To set up the demonstration:

1. Run the `demobld` SQL script under `$ORACLE_HOME/forms45/sql`. This script automatically runs during the installation of Forms if you elected to install the Forms demonstrations.

   To run the `demobld` script, enter the following:

   $ cd $ORACLE_HOME/forms45/sql
   $ sqlplus scott/tiger @demobld

   To properly display the demonstrations, the following settings are recommended in the `Tk2Motif.rgb` file:

   ```
   Tk2Motif*pushb.defaultButtonShadowThickness: 0
   Tk2Motif*pushb.shadowThickness: 2
   Tk2Motif*pushb.highlightThickness: 1
   Tk2Motif*expandNonDefaultButtons: True
   ```

2. Set the following environment variables (use a colon to separate multiple elements):

   **Table 11–1 Required Environment Variables**

<table>
<thead>
<tr>
<th>Environment Variable</th>
<th>Should Include</th>
</tr>
</thead>
<tbody>
<tr>
<td>PATH</td>
<td>The directory where the <code>xedit</code> executable resides.</td>
</tr>
<tr>
<td>TK23_ICON</td>
<td><code>$FORMS45/demos/icons</code></td>
</tr>
<tr>
<td></td>
<td><code>$RW25/demo/reqfiles</code></td>
</tr>
<tr>
<td></td>
<td><code>$GRAPHICS25/demos/forms</code></td>
</tr>
<tr>
<td>FORMS45_PATH</td>
<td><code>$FORMS45/demos/start</code></td>
</tr>
<tr>
<td></td>
<td><code>$FORMS45/plsqlib</code></td>
</tr>
<tr>
<td></td>
<td><code>$GRAPHICS25/demos/forms</code></td>
</tr>
<tr>
<td></td>
<td><code>$RW25/demo/reqfiles</code></td>
</tr>
<tr>
<td>GRAPHICS25_PATH</td>
<td><code>$GRAPHICS25/demos/forms</code></td>
</tr>
<tr>
<td>REPORTS25_PATH</td>
<td><code>$RW25/demo/reqfiles</code></td>
</tr>
<tr>
<td>FORMS45_UNKNOWN</td>
<td>Points to the directory where your <code>Tk2Motif.rgb</code> file resides.</td>
</tr>
</tbody>
</table>
3. To ensure that the demonstration applications run correctly on Motif, modify your Tk2Motif.rgb file to include the following settings.

   Tk2Motif*pushb.defaultButtonShadowThickness: 0
   Tk2Motif*pushb.shadowThickness: 2
   Tk2Motif*pushb.highlightThickness: 1

   You may want to copy your default Tk2Motif.rgb file (located in $ORACLE_HOME/guicommon2/tk23/admin) to another directory, and use the FORMS45_UNKNOWN environment variable to point to the directory where the modified Tk2Motif.rgb file resides.

4. Generate the necessary forms and menus, after setting the above environment variables:

   Note: The generated forms and menus are already present, so this step can be skipped. You can go directly to running the demonstrations.

   a. From $ORACLE_HOME/forms45/demos/4othello, enter the following:
      
      genform45m module=4othello userid=scott/tiger module_type=form

   b. From $ORACLE_HOME/forms45/demos/chess, enter the following:
      
      genform45m module=chess userid=scott/tiger module_type=form
      genform45m module=chess userid=scott/tiger module_type=menu

   c. From $ORACLE_HOME/forms45/demos/dfltmenu, enter the following:
      
      genform45m module=menudef userid=scott/tiger \module_type=menu

   d. From $ORACLE_HOME/forms45/demos/drag, enter the following:
      
      genform45m module=drag userid=scott/tiger module_type=form

   e. From $ORACLE_HOME/forms45/demos mdi, enter the following:
      
      genform45m module=mdi userid=scott/tiger module_type=form
      genform45m module=mdi1 userid=scott/tiger module_type=form
      genform45m module=mdi2 userid=scott/tiger module_type=form
f. From $ORACLE_HOME/forms45/demos/plsqllib, enter the following:

```
genform45m module=d2kdlstr userid=scott/tiger module_type=library output_file=d2kdlstr.dll
ngenform45m module=d2kwinc userid=scott/tiger module_type=library output_file=d2kwinc.dll
ngenform45m module=demo userid=scott/tiger module_type=library output_file=demo.dll
ngenform45m module=demo_os userid=scott/tiger module_type=library output_file=demo_os.dll
ngenform45m module=drag userid=scott/tiger module_type=library output_file=drag.dll
ngenform45m module=generic userid=scott/tiger module_type=library output_file=generic.dll
ngenform45m module=hint userid=scott/tiger module_type=library output_file=hint.dll
ngenform45m module=og userid=scott/tiger module_type=library output_file=og.dll
ngenform45m module=ogof userid=scott/tiger module_type=library output_file=ogof.dll
ngenform45m module=toolbar userid=scott/tiger module_type=library output_file=toolbar.dll
ngenform45m module=wizard userid=scott/tiger module_type=library output_file=wizard.dll
```

g. From $ORACLE_HOME/forms45/demos/sync, enter:

```
genform45m module=sync userid=scott/tiger module_type=library
```

h. From $ORACLE_HOME/forms45/demos/toolbar, enter:

```
genform45m module=toolbar userid=scott/tiger module_type=library
```

i. From $ORACLE_HOME/graphics25/demos/forms, run setup.sh to generate additional forms, menus, and libraries needed for the Oracle Graphics portion of the demonstration.

j. From $ORACLE_HOME/forms45/demos/start, enter:

```
genform45m Module=start Userid=scott/tiger Module_Type=form
```
The Integrated Demonstration for Developer/2000

Running the Developer/2000 Integrated Demonstration

11-5

genform45m Module=start Userid=scott/tiger Module_Type=menu
genform45m Module=aboutbox Userid=scott/tiger Module_Type=form
genform45m Module=demogref Userid=scott/tiger Module_Type=form
genform45m Module=demogref Userid=scott/tiger Module_Type=menu
genform45m Module=demogref Userid=scott/tiger Module_Type=form
genform45m Module=demogref Userid=scott/tiger Module_Type=menu
genform45m Module=demoref Userid=scott/tiger Module_Type=form
genform45m Module=demoref Userid=scott/tiger Module_Type=menu
genform45m Module=getparam Userid=scott/tiger Module_Type=form

g. From $ORACLE_HOME/reports25/demo/reqfiles, enter:

   genform45m Module=ordemos Userid=scott/tiger Module_Type=form
genform45m Module=ordemos Userid=scott/tiger Module_Type=menu
genform45m Module=ordemos2 Userid=scott/tiger Module_Type=form
genform45m Module=ordemos2 Userid=scott/tiger Module_Type=menu

h. From $ORACLE_HOME/graphics25/demos/forms, enter:

   genform45m Module=ogdemos Userid=scott/tiger Module_Type=form
genform45m Module=ogdemos Userid=scott/tiger Module_Type=menu
genform45m Module=usa Userid=scott/tiger Module_Type=form
genform45m Module=usa Userid=scott/tiger Module_Type=menu

5. To run the demonstration, enter the following from forms45/demos/start:

runform45m start scott/tiger

Note: For instructions on installing and running the Integrated Demos on the Web, see WEBREAD1.htm located in
$ORACLE_HOME/forms45/demos/webdemos.
User exits are subroutines that contain embedded SQL commands. You can create user exits by modifying the sample source file.
User Exits

The sample files, iapxtb.c and ue_xtb.c, each declare a user exit array called iapxtb[]. Following are the files that describe which file is used to define exit tables:

- Forms uses $ORACLE_HOME/forms45/demos/sample/ue_xtb.c.
- Reports uses $ORACLE_HOME/reports25/demo/ue/*
- Graphics uses $ORACLE_HOME/graphics25/demos/sample/iapxtb.c.

To create user exits:

1. Add entries to the sample source file for each user exit. Following is a sample source file:

   ```c
   /* Define the user exit table */
   extern exitr iapxtb[] = { /* Holds exit routine pointers */
   "UE_OK", ue_ok, XITCC,
   "UE_ERR", ue_err, XITCC,
   "UE_MB", ue_mb, XITCC,
   "UE_EMP_PLAN", ue_emp_plan, XITCC,
   (char *) 0, 0, 0   /* zero entry marks the end */};
   /* end iapxtb */
   ```

   The first item in the entry is the name (inside double quotes) used by the tool to reference the user exit. The second item is the actual name of the user exit routine. Names of user exits cannot be more than 30 alphanumeric characters in length, and must begin with a letter. The last item (XITCC) indicates that the user exit is called using C calling conventions. For other languages, you would use one of the following:

   - XITCOB /* COBOL */
   - XITFOR /* FORTRAN */
   - XITPLI /* PL/I */
   - XITPAS /* PASCAL */
   - XITAda /* ADA */

2. After modifying the source file, compile it along with your user exit program. Next, link the resulting IAPXTB object file with the product executable(s).
Forms

To link the user exit sample file for Forms, enter the following.

For Motif:

$ cd $ORACLE_HOME/forms45/lib
$ make -f ins_forms45w.mk f45runmx

For character mode:

$ cd $ORACLE_HOME/forms45/lib
$ make -f ins_forms45w.mk f45runx

Note: If you have the Developer/2000 Client/Server only release, replace ins_forms45w.mk with ins_forms45d.mk.

Reports

To link the user exit sample for Reports, enter the following.

For Motif:

$ cd $ORACLE_HOME/reports25/lib
$ make -f ins_reports25w.mk r25runmx

For character mode:

$ cd $ORACLE_HOME/reports25/lib
$ make -f ins_reports25w.mk r25runx

Note: If you have the Developer/2000 Client/Server only release, replace ins_reports25w.mk with ins_reports25d.mk.
Graphics

To link the user exit sample for Graphics, enter the following.

$ cd $ORACLE_HOME/graphics25/lib
$ make -f ins_graphics25w.mk g25runmx

Note: If you have the Developer/2000 Client/Server only release, replace ins_graphics25w.mk with ins_graphics25d.mk.

Linking in Your User Exits

To link in your own user exits, override the EXITS make file macro on the command line with the user exit table file and user exits you created. For example:

$ make -f ins_reports25w.mk \
  EXITS="my_iapxtb.o userexit1.o userexit2.o ..." r25runmx

Note: If you have Developer/2000 Client/Server only release, replace ins_reports25w.mk with ins_reportsd.mk.
Configuring Toolkit Resources

The Resource Database

The resource database is automatically constructed by the function `XtDisplayInitialize()`. You do not need to take any steps, because the function `XtDisplayInitialize()` is called by the execution of the Motif products, rather than by the user. The following information is provided as an explanation of the process that takes place when the resource database is constructed. This database is loaded from several sources, in the following order.

1. The tool-specific user resource file, Tk2Motif, is loaded first.
   Oracle Toolkit searches for this file in a number of places including
   `/usr/openwin/lib/app-defaults`.
   
   **WARNING:** Do not move the Tk2Motif file to the `/usr/openwin/lib/app-defaults` directory, as this may override critical internal Oracle Toolkit resources.
   
   By convention, keep the per-user settings in the `$HOME/Tk2Motif` file.

2. The resource database is loaded with resources that were loaded into the Resource_Manager property of the root window of the X display using `xrdb`.
   If this property is not set, the resources are loaded from the file `.Xdefaults` in the user’s home directory.

3. Any file named in the XENVIRONMENT environment variable is loaded if the variable is set and the file exists.
   It is also loaded with any file named `$HOME/.Xdefaults-hostname`, where hostname is the name of the machine where the client application is running.
4. The resource database is loaded with any resources corresponding to standard X command line arguments such as -fg, -bg, and so on.

5. After the resource database is created by XtDisplayInitialize(), Tk2Motif.disptype files are read and merged nondestructively into the database; i.e., values already in the database take precedence.

Resources specified in these files begin with the application class name rather than the application name. The naming convention for the filenames is as follows:

$ORACLE_HOME/guicommon2/tk23/admin/Tk2Motif.disptype

Where disptype is the display type suffix (.rgb, .gs, or .bw)

These files are the only ones that have the display type suffix. Although they are read last, their resource values are merged in as if they were loaded first, because the display type is unknown until after XtDisplayInitialize() is called. Setting color resources when running applications on some monochrome displays can crash the application. The XtDisplayInitialize() function does not provide a means of automatically selecting resource files based on the display type.

See Also: The X Window System documentation set.

Set the Font Search Path with the xset Utility

Use the xset utility to specify preferences for the display and keyboard. For example, you can use the xset utility to set the server’s font path.

Font Directories: On a workstation, fonts are loaded into the server from files stored in different directories, usually in subdirectories of /usr/openwin/lib/X11/fonts. When an application requests a particular font, the server searches a subset of these directories in a certain order. The font path determines which directories are searched, and in what order.

Font paths are system-dependent. Later in this section you will see how to query your current setting.
Each font directory contains font files, a `fonts.dir` file, and a `fonts.alias` file. When the X server searches directories in the font path, it uses these two files to find the fonts it needs.

`fonts.dir` This file contains a list of all fonts in the directory with their associated font names, in two-column format. The first column gives font file names; the second gives actual font names.

`fonts.alias` This file lists available aliases for fonts in the directory in a two-column format. The first column gives the aliases, the second gives actual font names.

**Screen Resolution:** Many vendors provide different sets of fonts for different screen resolutions. These are kept in directories with names that indicate different resolutions, such as 75dpi and 100dpi. The order of these two directories in the search path is important. For example, if your screen has 75 dots per inch, but the 100dpi directory of a given font is in front of its 75dpi directory in the font path, there may be unexpected results when you use this font.

To query current settings, enter:

```
$ xset q
```

If you discover that your paths are in the wrong order, you can use `xset` to correct them. Use the following syntax to override the current font path and set it to new directories:

```
xset fp directory[, directory...]  
```

Use the `fp` option to specify the font path. There must be at least one directory. Multiple directories are separated by commas.

To restore the font path to the server’s default setting, enter:

```
$ xset fp default
```

The simplest way to find available font names for font specification is to use the `xfontsel` utility, which is an interactive program that lists names of all the fonts and displays them. This utility is not available on all systems.
Manage Resources with the xrdb Utility

The appearance and behavior of most X and Motif applications can be customized to an almost limitless degree. Many users maintain a file called .Xdefaults in their home directory for default settings of colors, fonts, and other aspects of application behavior. You can use the xrdb utility to load the contents of this file into the X server's memory, which is called the X resource database.

The advantage of using xrdb is that these resource settings are used by tools running on all the different client machines you use, not just on the one containing the .Xdefaults file.

Control Windows with a Window Manager

The window manager is a utility that gives you control over windows on your display. It provides an interface for moving, resizing, iconifying, de-iconifying, and changing the stacking order of windows (note that all windows at all times are movable under Motif). Use the Motif Window Manager (mwm), OPEN LOOK Window Manager (olwm), or Desktop Window Manager (dt.wm) with Oracle Motif tools.

Note: Solaris 2.4 users need to follow instructions in the Solaris 2.4 Software Developer Kit Release Manual to configure their systems for Motif and the Motif Window Manager (mwm).

Configure Your Environment for Motif

This section is organized as follows:

- Overview of Resource Files
- X Resource Files
- Oracle Toolkit Resource Files
- Overlapping Motif and Oracle Terminal (Motif) Key Mappings

Overview of Resource Files

Oracle tools using the Motif interface employ two types of resource files: X resource files and Oracle Toolkit resource files. Resource files:

- simplify customization of applications designed on one platform (such as Microsoft Windows) to run on another platform (such as Motif)
- can adapt applications for different screens and keyboards
allow users to set preferences such as fonts and colors

Oracle tools are built on top of a layer called Oracle Toolkit, which provides a uniform programming interface to objects in the underlying user interface such as Motif, Microsoft Windows, or the Macintosh Toolbox. In Motif, Oracle Toolkit presents an interface to the Oracle Motif application user, made up of familiar Motif widgets.

Resources in theTk2Motif files are directed at actual Motif widgets. There are dozens of resources that may be set for each type of Motif widget. Most of these resources should not be modified. You may want to experiment, however, with color and font resources.

Resources in the.res files describe attributes of Oracle Toolkit objects. In many cases, but not always, there is a direct correspondence between an attribute of a Toolkit object, and a resource of an underlying Motif widget. In these cases, the Toolkit attribute takes precedence. For example, most Toolkit controls, or views, have an attribute, bgcolor, which determines background color of the control. If this is set in the.res file, the value set overrides any setting of the background resource for the corresponding widget class in theTk2Motif file.

In some cases, a widget resource may have no Toolkit counterpart. For example, Oracle Toolkit provides no means of setting the font in an alert dialog box. Therefore, if you want to draw extra attention to your alerts, you can display their warning messages in a 24-point boldface font by entering the following into yourTk2Motif file:

```
Tk2Motif*alert*fontList: -*-*-medium-b-normal-*-240-*/
```

**X Resource Files**

The X Resource Files contain a listing of the Motif resource settings and the Widgets which are supported by the Toolkit and used by Developer/2000 tools. The relevant X resource files are as follows:

```
$ORACLE_HOME/guicommon2/tk23/admin/Tk2Motif.[bw|gs|rgb]
```

Each of these files contains one of the following filename extensions:

- **bw** The bw extension is for monochrome (black and white) display.
- **gs** The gs extension is for grayscale displays.
- **rgb** The rgb extension is for color displays and the color scheme defaults to sky blue. The alternate color displays are as follows:

```
rose: The rose extension sets windows to a rose color.
```
The file Tk2Motif.rgb, which sets your Developer/2000 windows to sky blue, is opened by Oracle Terminal to initialize color display resources. If you want to set your Developer/2000 windows to something other than sky blue, you must rename the gray, rose, or steel files to be Tk2Motif.rgb. For example, if you want rose-colored Developer/2000 windows, enter:

$ cd $ORACLE_HOME/guicommon2/tk23/admin
$ mv Tk2Motif.rgb Tk2Motif.skyblue
$ cp Tk2Motif.rose Tk2Motif.rgb

When you restart the application, Developer/2000 windows will be rose-colored.

If you want to change a single user's environment to rose-colored windows, enter:

$ cp Tk2Motif.rose $HOME/Tk2Motif

Oracle Toolkit Resource Files

The Oracle Toolkit resource file $HOME/Tk2Motif contains resource settings customized for the individual user. (HOME is a user's home directory.)

The files under ORACLE_HOME are provided by Oracle. These files usually are modified only by a system administrator, because these resource settings affect all users of the system. Users who want to customize these resources should copy one of these files to a file named Tk2Motif in their home directory and edit it there.
Set Oracle Toolkit/Motif Resources in the Tk2Motif File

This section explains briefly how to set resources in the Tk2Motif file. The Tk2Motif file contains important information and comments. Read these comments carefully before modifying the file. You should also have a thorough understanding of X and OSF/Motif resources before you attempt to modify this file.

Example 1

The following example shows how the specifications in a user's $HOME/Tk2Motif file override specifications in the file $ORACLE_HOME/guicommon2/tk23/admin/TK2Motif.rgb.

In this scenario, the file $ORACLE_HOME/guicommon2/tk23/admin/TK2Motif.rgb contains the following:

Tk2Motif*fontList: -*-helvetica-medium-r-normal-*-120*
Tk2Motif*drawn.background: lightblue
Tk2Motif*pushb.background: salmon

A user's $HOME/Tk2Motif file contains:

browserm*pushb.background: steelblue
browserm*fontList: -*times-medium-r-normal-*-120-*-31

In this example, buttons in a Browser window would be drawn in Times font with a steel blue background, surrounded by a light blue drawn view. The Helvetica font setting and salmon pushbutton background for the Tk2Motif application class would be ignored.

Example 2

To set the font for labels in all top menus to 12-point Helvetica, make sure that this font is supplied on your system (using xlsfonts or xfontsel). Make an entry similar to the following in the Tk2Motif file:

Tk2Motif*menubar*fontList: -*-helvetica-medium-r-normal-*-120-*-1

Note: The previous example should be entered on one line in the Tk2Motif file.
Example 3
To set the background and foreground colors in all Alert boxes, first check the rgb.txt file for the list of possible colors. If you prefer orange and yellow, and these colors are available, enter the following lines in your Tk2Motif file:

```
Tk2Motif*alert*background: orange  
Tk2Motif*alert*foreground: yellow
```

Example 4
With any X resource, you can restrict values to apply only to widgets belonging to a particular hierarchy. For example, you can set the scroll bar trough color to red when the scroll bar is part of a file dialog window, but black in all other cases, by entering the following lines in your Tk2Motif file:

```
Tk2Motif*scrollBar*troughColor: black  
Tk2Motif*filedialog*scrollBar*troughColor: red
```

Overlapping Motif and Oracle Terminal (Motif) Key Mappings
The Oracle Toolkit/Motif key mappings are stored in the .res Oracle Terminal file. You can customize a key map with the Oracle Terminal interactive interface.

If you want to change any of the default key definitions, you must take into consideration two important factors:

- Motif and Oracle key definitions may overlap.
  Many OSF/Motif widgets have internal translation tables that map particular function keys to particular widget actions. For example, the [Tab] key is mapped to the Next Field action.
  When these actions overlap with the functions of Oracle Toolkit Motif tools (as is the case with the [Tab] key), both mappings must agree. Do not override such mappings.

- Motif has reserved key mappings.
  There are some key mappings that are reserved for OSF/Motif. Do not override these key mappings.
Index

A
administering
- Forms, 5-3
- Graphics, 7-3
- Oracle Book, 10-3
- Procedure Builder, 82
- Reports, 6-3

B
Browser
- brwdrp20.sql script, 99
- color, 93
- database tables, 94
- demonstrations, 99
- documentation, 92
- dropping demonstration tables, 99
- executables, 93
- font, 93
- installing, 93
- using, 99
- Browser profile table, 95
- brwble20.sql script, 98
- brwdrp20.sql
  - Browser, 99
- brwprf20.sql script, 95
- brwupg20.sql script, 94

C
call interface
- Reports, 6-6
character mode

D
demonstrations
- Browser, 99
- Oracle Book, 10-6
- Reports, 6-16
designer
- Forms, 5-6
- Graphics, 7-6
- Oracle Book, 10-5
- Reports, 6-13
Developer/2000
- introduction, 1-2
- overview, 1-3
disk space
- calculating, 1-14
- disk space and memory requirements, 1-14
documentation
- Browser, 92
- Forms, 5-2
- Graphics, 7-2
- online, 1-10

Developer/2000 tools supporting, 1-9
client-based
- diagram, 1-5
- installs, 1-4
- issues to consider, 1-8
- performance, 1-8
- conventions used, ix
- converter
  - Oracle Book, 10-5
cue cards, 1-11
Drag demonstration, 5-8

E
environment
setting up, 4-15
environment variables
  DEBUG_SLFIND, 4-7
  Forms, 5-4
  FORMS45_PATH, 5-4
  FORMS45_TERMINAL, 5-4
  Graphics, 7-5
  GRAPHICS_PATH, 7-5
  Oracle Book, 10-3
  ORACLE_PATH, 7-5
  ORACLE_TERM, 4-5, 5-4, 6-10, 10-4
  Reports, 6-9
  REPORTS25_PATH, 6-10
  REPORTS25_TERMINAL, 6-9
  REPORTS25_TMP, 6-12
  TERM, 5-4, 10-4
  TK2_PRINT, 4-12
  TK2_PRINT_STATUS, 4-12
  TK23_FONTALIAS, 4-11
  TK23_ICON, 5-5, 6-12
  TK23_TERMINAL, 6-12
  TMPDIR, 5-5
EUL tables, 98
executables
  Browser, 93
  Forms, 5-3
  Graphics, 7-3
  Oracle Book, 10-3
  Procedure Builder, 82
  Reports, 6-3

F
file extensions

G
Game of 40thello demonstration, 5-9
Graphics
  administering, 7-3
designer, 7-6
documentation, 7-2
environment variables
  GRAPHICS_PATH, 7-5
executables, 7-3
introduction, 1-3
online help, 7-2
overview, 1-3
README.doc, 7-2
runtime, 7-5
using, 7-5
GRAPHICS_PATH, 7-5

H
hardware requirements, 1-12
help
  context-sensitive, 1-10
  online, 1-10
HTML Converter
  Oracle Book, 10-6

I
implementations
  character mode, 1-9
  Motif, 1-9
  Web, 1-9
installation
  client-based, 1-4
  issues to consider, 1-8
  options, 1-4
  same directory, 1-8
  separate directories, 1-8
  server-based, 1-4
installing
  Browser, 93
introduction to Developer/2000, 1-2

M
memory
  requirements, 1-14
Motif
  Developer/2000 tools supporting, 1-9

N
National Language Support, 1-17

O
online documentation, 1-10
  viewing, 4-4
online help, 1-10
  Forms, 5-2
  Graphics, 7-2
  Oracle Book, 10-2
operating system
  requirements, 1-12
  Oracle Book, 10-4
  administering, 10-3
  converter, 10-5
  demonstrations, 10-6
  designer, 10-5
  documentation, 10-2
  environment variables, 10-3
    ORACLE_TERM, 10-4
  executables, 10-3
  HTML Converter, 10-6
  introduction, 1-3
  online help, 10-2
  overview, 1-3
  preference files, 10-3
  README.doc, 10-2
  runtime, 10-5
  using, 10-5
Oracle Browser
  introduction, 1-3
  overview, 1-3
Oracle Chess demonstration, 5-9
Oracle Forms, 5-4
Oracle Reports, 6-10
ORACLE_PATH, 7-5
ORACLE_TERM, 5-4, 6-10, 10-4
Oracle7 Server
  documentation, 1-11
  overview
    Developer/2000, 1-3
performance, 1-8
preface
  Send Us Your Comments, vii
preference files
  Oracle Book, 10-3
  prefs.ora
    Reports, 6-4
  prefs.ora file, 4-6
Print Document option, 6-5
printer
default
  setting of, 4-10
  PPD file, 4-8
  setting configuration, 4-8
setting variables, 4-12
printer definitions, 6-8
printing
Reports, 6-12
Procedure Builder
administering, 82
documentation, 82
eexecutables, 82
introduction, 1-3
overview, 1-3

R

README.doc
Graphics, 7-2
Oracle Book, 10-2
Reports, 6-2
relinking
Reports, 6-4
Reports
administering, 6-3
ASCII output, 6-15
call interface, 6-6
demonstrations, 6-16
designer, 6-13
documentation, 6-2
environment variables
ORACLE_TERM, 6-10
REPORTS25_PATH, 6-10
REPORTS25_TERMINAL, 6-9
REPORTS25_TMP, 6-12
setting, 6-9
executables, 6-3
file extensions, 6-5, 6-7
online tools, 6-8
prefs.ora, 6-4
Print Document option, 6-5
printer definitions, 6-8
printers, 6-13
printing
specifications, 6-12
spoolcmd, 6-12
spoolpr.sh script, 6-12
README.doc, 6-2
runtime, 6-13
SQL scripts, 6-8
using, 6-13
reports
sending through mail, 6-14
REPORTS25_PATH, 6-10
REPORTS25_TERMINAL, 6-9
REPORTS25_TMP, 6-12
requirements
CPU, 1-12
database, 1-13
disk space and memory, 1-14
for Oracle
operating system, 1-12
hardware, 1-12
media device, 1-12
memory, 1-12
relinking, 1-13
server, 1-13
swap space, 1-12
user interface, 1-13
restrictions, 1-17
server-based, 1-7
runtime
Forms, 5-6
Graphics, 7-5
Oracle Book, 10-5
Reports, 6-13
S
Send Us Your Comments
boilerplate, vii
server-based
diagram, 1-6
installs, 1-6
issues to consider, 1-8
restrictions, 1-7
spoolcmd, Reports, 6-12
spoolpr.sh script, Reports, 6-12
SQL scripts, Reports, 6-8
swap space
requirements, 1-12
Synchronization demonstration, 5-7
T
TERM,  5-4, 10-4
TK23_ICON,  5-5, 6-12
TK23_TERMINAL,  6-12
TMPDIR,  5-5
Toolbar demonstration,  5-8

U
uifont.ali file,  4-11
uiprint.txt file,  4-10
user interface
   requirements,  1-13
using
   Oracle Book,  10-5

W
Web
   Developer/2000 tools supporting,  1-9